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UBC	  DIGITAL	  SIGNAGE	  –	  ACCESS	  and	  AUTHENTICATION	  FOR	  ADMINISTRATORS	  
	  

Digital	  signage	  administrators	  will	  have	  access	  to	  schedule	  and	  manage	  content	  for	  display.	  
	  
During	  the	  installation	  and	  configuration	  phase	  for	  units	  (i.e.	  Faculty,	  Departments,	  Schools,	  Clubs	  
etc),	  designated	  administrator	  will	  have	  the	  required	  client	  application	  software	  installed	  and	  
configured	  installed	  on	  their	  PCs.	  Currently,	  the	  Digital	  Signage	  service	  is	  based	  on	  the	  CoolSign	  
software.	  
	  
The	  following	  two	  steps	  are	  required	  in	  order	  to	  access	  the	  digital	  signage	  service	  for	  
administrators:	  
	  

• Establishing	  proper	  network	  connectivity	  
• Logging	  into	  the	  CoolSign	  Network	  Manager	  Application	  (CNM)	  
	  

	  
	  
NETWORK	  CONNECTIVITY	  

• Start	  the	  “Cisco	  AnyConnect	  VPN	  Client”	  
• Enter	  the	  following	  credentials:	  

Connect	  to:	  myvpn.ubc.ca	  
Username:	  {CWL	  ID}.esignage.prod	  
Password:	  {your	  CWL	  password}	  
	  

	  
	  
LOGGING	  INTO	  COOLSIGN	  

Administrators	  can	  choose	  to	  either	  log	  in	  by	  providing	  an	  ID	  and	  password	  each	  time	  or	  to	  have	  
the	  CNM	  application	  use	  the	  Windows	  EAD	  authentication	  token	  (provided	  when	  the	  user	  logged	  
into	  the	  Windows	  EAD	  domain)	  and	  automatically	  log	  into	  CoolSign	  (i.e.	  effect	  EAD	  single	  sign-‐on	  
which	  requires	  that	  the	  administrator	  has	  been	  previously	  EAD	  enabled).	  	  
	  
During	  installation	  and	  configuration,	  administrators	  must	  choose	  one	  of	  the	  login	  processes	  –	  but	  
not	  both.	  	  
	  
LOGGING	  IN	  WITH	  AN	  COOLSIGN	  ID	  

A	  CoolSign	  username	  will	  be	  created	  that	  matches	  the	  administrator’s	  CWL	  ID.	  The	  
administrator	  will	  set	  the	  password	  for	  this	  ID	  –	  note,	  the	  CoolSign	  ID/password	  is	  not	  
automatically	  synchronized	  with	  the	  CWL	  repository.	  
	  
• Start	  the	  CNM	  application	  	  
• Enter	  your	  CoolSign	  ID	  and	  password	  

	  
EAD	  SINGLE	  SIGN-‐ON	  INTO	  COOLSIGN	  

• Log	  into	  your	  PC	  using	  your	  EAD	  domain	  ID	  and	  password	  
• Start	  the	  CNM	  application	  
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Note: If you hold down the left CTRL key while CoolSign is starting up, the login window appears 
even if you are using domain security.

To connect to a CoolSign network:

1. Enter your username.

2. Enter your password.

Note: Passwords are case-sensitive. Make sure you don’t accidentally have the CapsLock key depressed 
when entering your password.

3. Select a network to connect to.

4. Click the Login button.

WARNING!  By default, the username for a CoolSign network is “admin” and the password is “password”. 
The login dialog automatically enters these default values for you.
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3. Using 
CoolSign Manager

CoolSign Manager is designed to provide easy yet customizable access to all the information 
and data you need to manage a digital signage network. With CoolSign Manager, you can 
import content, create channels and playlists, tune players, and monitor network transfers and 
status.

CoolSign Manager is organized into different screens that allow you to view and manage 
different areas of your network:

Home Manager—Provides a high-level dashboard where you can quickly get a picture 
of the overall status and health of your network. Important alerts that may require 
your attention or management are displayed in the Alerts grid on the Home Manager, 

along with a log of all major actions that have been performed with CoolSign Manager.

Content Manager—Lets you view the entire repository of content available on your 
CoolSign network. You can import new content, modify numerous content properties 
that affect how the content is played back, retrieve the play history for content, and 

more.

Audio Manager—Similar to the Content Manager, but specialized for managing audio 
content only. You can import MP3 files directly into the Audio Manager without 
needing to run them through Content Wizard.

DataTable Manager—CoolSign uses data tables to provide dynamic data to content 
and scheduling expressions. With the DataTable Manager, you can manually create 
new data tables or input data into existing data tables.

DataWatcher Manager—(Optional.) You can install the Data Watcher to provide a 
bridge between a data source and a CoolSign network. The Data Watcher can read 
data from various types of data sources, parse that data, and then import it into a 

CoolSign data table.

Channel Manager—Channels are the master schedules that you tune your players to. 
You can use the Channel Manager to create new channels and schedule content or 
playlists into channels. Once a channel is created, you can then use the Player Manager 

to tune players to your channel so they start playing the scheduled content.

Playlist Manager—Playlists are specialized sub-schedules that you can insert into 
channels. Playlists provide extensive flexibility in how you create your schedules. You 
can use the Playlist Manager to create, edit, or delete playlists and to schedule content 

within the playlists.

Player Manager—Players are the nodes in your network that play back content on a 
display device. The Player Manager provides functionality to manage your players, 
including the ability to remotely configure players, divide a player into multiple 

regions, tune a player to a channel, and review the play history for a player.
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Network Manager—Lets you see every node of your network and manage technical 
properties like software versions, bandwidth control, and configuration. Primarily 
intended for technical users, the Network Manager enables you to troubleshoot 

network issues and take corrective action when necessary.

To navigate to a manager screen:

Do one of the following:

• Click the manager’s icon in the navigation bar on the left side of the screen.
• Choose Views > Go To >.

About manager pages

With the exception of the Home Manager, each of the manager screens share similar layouts 
and functionality. While the type of item that each screen manages differs, each manager 
provides the ability to customize how your data is displayed and to organize the data in ways 
that make sense to your specific use of the digital media network.

The quickbar gives you tools 
to quickly filter or view sets of 
items in the data grid. 

The data grid shows the avail-
able items for each specific man-
ager. 

 You can right-click an item to 
display a context-sensitive 
popup menu of actions for 
the item. 

Change the view of the data 
grid from this combobox. 

The status bar tells you how many items 
you have selected in the data grid plus 
other useful information.
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About the data grid

The most important element in each manager is the data grid. The data grid displays the items 
available in your network in a grid-like table of rows and columns. The data grid is a powerful 
tool that can be used to organize and customize what information you see about each of the 
objects in your network.

Working with items in the data grid
Each manager page’s data grid lists all the available items of the specific type managed by that 
page. You can use the data grid to select one or more items and then perform context-
sensitive actions on them. 

Selecting items in the data grid

Before you can perform an action on an item, you must select it in the data grid. The selected 
items in a data grid are highlighted in blue.

To select an item:

Do one of the following:

• Click the item in the data grid.
• Use the up and down arrow keys to change the current selected item.

To select multiple items:

Do one of the following:

• Hold the Shift key down and click an unselected item to select all the items between the 
currently selected item and the clicked item.

• Hold the Ctrl key down and click an unselected item to add that item to the set of currently 
selected items.

To deselect an item:

Do one of the following:

• Hold the Shift key down and click a selected item to unselect all the items between the last 
clicked item and the clicked item.

• Hold the Ctrl key down and click a selected item to remove that item from the set of 
currently selected items.

Performing context-sensitive actions on an item

Once you have selected an item in the data grid, you can perform context-sensitive actions on 
it. The type of item determines the actions you can perform.

The following chapters describe specific actions you can perform in each manager page.
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To perform an action on an item:

Do one of the following:

• Choose an action from the Actions menu.
• Right-click the item or selected items and choose an action from the Actions popup menu.

Changing the data grid layout
CoolSign provides a number of predefined views for each manager page. Each view defines 
which columns are displayed, how the grid is sorted, and any groupings that are applied to the 
grid.

For more information on managing views and adding new views, see “Managing views” on 
page 47.

To change the data grid view:

Use the view combobox to select the view you wish to use.

Sorting columns

You can sort the items visible in the data grid by one or more columns. You can add additional 
columns to the current sort by holding down the shift key while sorting.

Tip: The currently sorted columns are saved with the view’s state. 

To sort a column:

To toggle between ascending and descending sort order, click on the header of the column 
you want to sort by. 

Grouping columns

You can group the items visible in the data grid by one or more columns. 

Tip: The currently grouped columns and the group by box toggle state are saved with a view’s state.

To group by a column:

Do one of the following:

• Right-click on the column header and choose Group By This Column.
• Drag a column into the Group By Box.

This content grid is 
grouped by the for-
mat column.
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To toggle the group box:
• Right-click on any column header and choose Toggle Group By Box.

To clear all groupings:
• Right-click on any column header and choose Clear Groupings.

Resizing columns

You can resize the visible columns to better fit the data displayed in the column. You can also 
lock the width of a column so that it doesn’t resize when you resize the entire CoolSign 
window.

Tip: Column widths are saved with a view’s state.

To resize a column:

Do one of the following:

• Click and drag on the column border to manually resize the column.
• Right-click on the column header and choose Best Fit. The column will be resized to best fit 

the data visible in the column.

Tip: To tell the grid to resize all the visible columns to best fit the data, hold down the Ctrl key while 
choosing Best Fit.

To lock a column width:

Right-click on the column header and choose Lock Column Width. The column will no longer 
resize automatically when the window is resized.

Changing which columns are visible

You can add or remove columns from the data grid if you want to include different pieces of 
information in your view.

Tip: Visible columns are saved with a view’s state.
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To add columns to a data grid:

1. Right-click on any column header and choose Choose Columns to show the Choose Col-
umns toolbox.

2. Select one or more columns in the Available Columns list.

3. Click the right arrow button to move the columns into the Show These Columns list.

4. Click Close.

To remove columns from a data grid:
• Right-click on the column header and choose Remove this column.

Lists all the available col-
umns that haven’t been 
added to the data grid.

Click to show the internal 
hidden columns. In most 
cases you will not find these 
columns useful.

Use the move buttons to move the 
selected columns between the available 
and shown lists.

Click this button to force all 
columns to resize to best fit 
the visible data.

Click this checkbox to shade 
every even row with a light 
gray color for easier viewing.

Use these buttons to move a 
selected column up or down in 
the list.

Lists all the columns that are visible 
in the data grid.
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Reordering columns

You can change the order in which the visible columns are displayed to better organize your 
data.

Tip: Column ordering is saved with a view’s state.

To reorder a column:

Click on the column header and drag the column left or right to reposition it.

Managing views
In addition to the predefined views that CoolSign Manager provides for each manager page, 
you can add additional views to further customize how you work with items. The Manage 
Views dialog allows you to create new views, edit and delete existing views, import or export 
views, and reset views to their default state.

To add a new view:

1. Choose Views > Manage Views to display the Manage Views dialog.

2. Click New.

3. Enter a name for the view.

4. Choose columns for your view See “Changing which columns are visible” on page 45.

To rename a view:

1. From the Manage Views dialog, click Rename.

2. Enter a new name for the view.

3. Click OK.

To delete a view:
• From the Manage Views dialog, click Delete.

Importing and exporting views

You can export views to a special CoolSign View File format (.cvw) so that you can transfer 
them between different CoolSign networks.

To export a view to a CoolSign View file:
• From the Manage Views dialog, click Export and enter a name to save your view.

To import a CoolSign View file:
• From the Manage Views dialog, click Import and choose a view file using the open file 

dialog.
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Resetting and restoring default views

CoolSign provides predefined default views for each of the manager pages. If you modify or 
delete these views, you can reset or restore them back to their default settings using the 
Manage Views dialog.

To reset a view back to its default settings:

1. From the Manage Views dialog, select the view to reset.

2. Click Reset View.

Note: You can only reset predefined default views created by CoolSign. User-created views cannot be 
reset.

To restore deleted default views:
• From the Manage Views dialog, click Restore Default Views.

Searching for items
You can filter which items are displayed in a data grid by using the Search dialog. 

To search for items:

1. To display the search dialog, do one of the following:

• Choose Tools > Search.
• Right-click in the QuickBar and choose New Search.
• Type Ctrl-F.

2. Define the search criteria using the Field, Condition and Value controls.

3. To create a search expression that contains multiple criteria, check the “Show Advanced 
Search” box.

4. Click Find. The results of your search are displayed in the data grid and a temporary Search 
item is created in the QuickSets panel.



Using CoolSign Manager

CoolSign v4.5  CoolSign Manager User Guide � 49

Note: Temporary search items are no longer available after you restart CoolSign Manager. To make the 
results of your search available to subsequent sessions, you can save your temporary search as a 
QuickSearch. See “Using QuickSearches” on page 50.

Using the QuickBar
Each manager page (except for the Home page) has a quickbar that contains tools to help you 
organize and filter the items that appear in the data grid. While each manager page can have 
page-specific quickbar features, all the quickbar panels contain the QuickSet panel.

About the QuickSet panel

The QuickSet panel is available for every manager page (except for the Home page) and lets 
you create QuickSets, QuickSearches, and Folders to help you organize your data.

Using QuickSets

QuickSets are user-defined categories that you create and add items to. When you click on a 
QuickSet in the QuickBar panel, the data grid immediately displays only the items that you 
have added to that QuickSet. QuickSets are not exclusive, so you can add an item to more than 
one QuickSet.

To create a new QuickSet:

1. Right-click anywhere in the QuickSet panel and choose New QuickSet.

2. In the QuickSet Properties dialog, enter a name for the new QuickSet.

3. Click OK.

This is a QuickSearch.

This is a temporary 
search.

This is a Folder.

This is a QuickSet.
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To add an item to a QuickSet:
• Select one or more items in the data grid and drag them onto the QuickSet.

To remove an item from a QuickSet:
• Right-click the item in the data grid and choose Remove From QuickSet.

To clear all the items from a QuickSet:
• In the QuickSet panel, right-click the QuickSet and choose Clear QuickSet.

To edit the properties of a QuickSet:
• Right-click the QuickSet and choose Edit QuickSet. You can change the QuickSet name or 

modify security settings.

To delete a QuickSet:
• Right-click the QuickSet and choose Delete QuickSet.

Note: Deleting a QuickSet does not delete the items in the QuickSet, just the QuickSet itself.

Using QuickSearches

QuickSearches are searches on your items that you can save persistently. When you click on a 
QuickSearch in the QuickSet panel, the data grid displays all the items that pass the filter 
expression of that QuickSearch. QuickSearches are “live”; if an item changes, the QuickSearch 
can automatically update to include the modified item.

Before you can create a QuickSearch, you must perform a search on the data grid. See 
“Searching for items” on page 48. After you define a search, a temporary search item named 
Search (in italics) is created in the QuickSet panel. If you like this search, you can save it as a 
QuickSearch so that it is always available and so that other users can access it.

To convert a temporary search to a QuickSearch:

1. Right-click on the temporary search item and choose Save as QuickSearch.

2. Enter a name for your new QuickSearch.

3. Click OK.
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To edit the filter expression on a QuickSearch:

1. Right-click on the QuickSearch and choose Edit QuickSearch. 

The QuickSearch Properties dialog appears.

2. Click the Edit button to modify the search criteria.

3. In the Search dialog, define the search criteria, then click Find (see “Searching for items” on 
page 48).

4. Click OK.

To delete a QuickSearch:
• Right-click on the QuickSearch and choose Delete QuickSearch.

Organizing QuickSets and QuickSearches

Folders allow you to better organize your QuickSets and QuickSearches. You can create folders 
and then drag QuickSets and QuickSearches into the folder. Clicking on a folder will display all 
the items in every QuickSet in the folder.

Note: You can use folders to help organize your QuickSearches, but folders do not aggregate the 
results of the QuickSearches stored in the folder. 

To create a new folder:

1. Right-click anywhere in the QuickSet panel and choose New Folder.

2. Enter a name for the new folder.

3. Click OK.

To add QuickSets or QuickSearches to a folder:
• Drag and drop the QuickSet or QuickSearch onto the folder. You can also nest folders 

within folders by dragging a folder onto another folder.
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To remove a QuickSet or QuickSearch from a folder:
• Drag the QuickSet or QuickSearch out of the folder into the lower blank area of the 

QuickSet panel.

To rename a folder:
• Right-click the folder and choose Rename Folder. 

To delete a folder:
• Right-click the folder and choose Delete Folder. You will be asked whether to delete the 

folder and its contents or just the folder.

Printing and exporting data
You can print or export the items displayed in any data grid. You can export data to Microsoft 
Excel or to a delimited text file.

To print the items displayed in a data grid:
• Right-click in any column header and choose Print Grid.

To export items to a file:

1. Right-click in any column header and choose Save Grid Data to File.

2. Choose the file format that will be used to save the data.

• Excel (*.xls)—Saves the data in Microsoft Excel format. There are no additional options 
for this format.

• Text (*.txt)—Saves the data as a delimited text file. You can use the Text export 
properties to set the delimiter character, whether fields should be quoted, and whether 
to pad data with spaces.

3. Select a name and location to save the file onto your hard drive.
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4. About 
Content

What is CoolSign content?
Content is perhaps the most important element within a CoolSign Digital Media 
Network.Without content, your screens would be dark. While CoolSign does not include tools 
for the authoring of digital assets like bitmaps and video, it supports most of the standard 
digital file formats used by today’s content creation applications including MPEG-2, Windows 
Media 9, Flash, Photoshop bitmaps and, with this release, PowerPoint slides.

Creating CoolSign content
The assets used within CoolSign content can be authored using any of the many available 
professional content authoring tools like Adobe After Effects, Adobe Photoshop, Adobe Flash, 
and Apple FinalCut Pro. Once you have created the digital assets for your content, you can 
convert those assets into CoolSign content by using the CoolSign Content Wizard. You can 
then use CoolSign Manager to import the CoolSign content saved out by these tools into a 
CoolSign network.

CoolSign Content Wizard 

The CoolSign Content Wizard is included with all CoolSign software and is designed to convert 
supported file formats into CoolSign content. The Content Wizard has a simple interface that 
allows you to import a file; set content properties like name, duration, and transition; select a 
thumbnail frame; and save out CoolSign content, all in a few quick steps. For more 
information, see the CoolSign Network Installation Guide.



Supported file formats

54 � CoolSign Manager User Guide © 2006-2010 CS Software Holdings LLC

Supported file formats
Assets for CoolSign content can be authored using numerous industry-standard production 
tools available from companies like Adobe, Avid, and others. The remainder of this chapter 
discusses requirements for developing assets for CoolSign.
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Using digital video in CoolSign
Digital video is the most popular format for authoring CoolSign content. Digital video can be 
created in any number of production tools including Adobe After Effects, Avid 
MediaComposer, Apple FinalCut Pro, and Adobe Premiere. The preferred formats for encoding 
and playback of digital video in CoolSign are MPEG-2 or Windows Media 9. Both formats are 
capable of high quality video playback at both SD and HD resolutions. The following digital 
video formats are supported by CoolSign:

• MPEG-4 (*.mpg)
• MPEG-2 (*.mpg)
• MPEG-1 (*.mpg)
• Windows Media Video 9 (*.wmv)
• Windows AVI (*.avi)
• CoolSign Encrypted Video (*.evf )

MPEG-2 

MPEG-2 is designed for broadcast-quality digitally encoded audio and video. It offers good 
image quality and is the standard for DVD video. Most authoring applications do not encode 
directly to MPEG-2 and require a 3rd-party encoding tool or plug-in. 

Note: MPEG-2 defines different standards for resolution and bit rate called profiles and levels. In order 
to encode MPEG-2 at greater resolution than NTSC (720x480), you will need an encoder that supports 
High Profile and High-1440 Level. Most hardware MPEG-2 encoders do not support the higher profiles 
and levels.

The following are some applications that can be used to encode MPEG-2:

• Adobe After Effects 6.5 (www.adobe.com)*
• Adobe Premiere Pro (www.adobe.com)
• MainConcept MPEG Encoder (www.mainconcept.com)*
• TMPGEnc Plus 2.5 (www.pegasys-inc.com)
• Discreet Cleaner XL (www.discreet.com)*Cleaner only supports encoding at 720x480.

CoolSign supports MPEG-2 program streams (multiplexed video/audio) or video elementary 
stream (video only) at data rates up to 15 Mbit/sec.

MPEG-1

While CoolSign fully supports MPEG-1 digital video, we recommend that MPEG-2 be used for 
its superior resolution and quality. In most cases, MPEG-1 can be encoded in the same way as 
MPEG-2.

http://www.adobe.com
http://www.mainconcept.com
http://www.pegasys-inc.com
http://www.discreet.com
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Windows Media 9

Microsoft Windows Media technology has recently become a viable alternative to MPEG-2 for 
full screen digital video playback. Windows Media has certain advantages: more authoring 
tools natively support encoding to WMV and, in many cases, the file size of Windows Media is 
significantly smaller than MPEG-2.

The following are some applications that can be used to encode Windows Media 9:

• Adobe After Effects 6.0 / Adobe Premiere Pro (www.adobe.com)
• Discreet Cleaner XL (www.discreet.com)
• Microsoft Windows Media Encoder 9 (www.microsoft.com)

Using Flash in CoolSign
CoolSign supports Shockwave Flash (SWF) vector animation format created in applications 
like Adobe Flash, Adobe LiveMotion and Adobe After Effects. 

SWF files exported as Versions 4–9 are supported.

WARNING!  You can only control the volume of SWF files that are version 8 or older.  With SWF version 9 
files, it is not possible to control the player volume from CoolSign.

SWF files for use with CoolSign should be authored at a playback speed of 30 frames per 
second. Lower frame rates can be used, but playback will appear choppier than movies 
created at full 30 fps. Take care to avoid animating complicated vector shapes, large bitmaps, 
and numerous objects simultaneously as this can result in poor playback performance. In 
these cases, it is recommended that you export into AVI or QuickTime format and then encode 
to MPEG-2 or WMV formats using a standalone encoding application.

Using bitmaps in CoolSign
If you don’t require animation in your content, CoolSign supports displaying static bitmap 
assets. Bitmap assets can be authored in any software that supports the following formats:

• Photoshop (*.psd)—Photoshop version 3.0 or higher supported.  Layered files will be 
flattened. Only RGB mode is supported. Only the first alpha channel will be used.

• Windows Bitmap (*.bmp)—Windows Bitmap can be saved as either 24-bit or 32-bit.
• JPEG (*.jpg)—JPEGs should be saved with maximum quality settings to minimize 

compression artifacts.
• Portable Network Graphics (*.png)
• Graphics Interchange Format (*.gif)—GIF animation is not supported.

Assets should be saved at 16-bit, 24-bit, or 32-bit color depth. 1-bit and 8-bit images are not 
supported.

http://www.adobe.com
http://www.discreet.com
http://www.microsoft.com/windows/windowsmedia/9series/encoder/default.aspx
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Note: CoolSign fully supports 32-bit images. If you are displaying 32-bit bitmap with an alpha channel, 
the transparent regions will be transparent to the black background. If you are using overlapping 
regions, you can use alpha channel transparency to show through from one region to the one below. 
Be sure to delete unwanted alpha channels before importing bitmap content as there is no mechanism 
for “turning off” an alpha channel once converted into content.

Using PowerPoint in Coolsign
With this 4.5 release, PowerPoint slides and shows can now be imported through the Content 
Wizard. With PowerPoint versions 2003-2007, slides must be in .jpg format. With the Office 
2010 version, you can now import .wmv movie presentations as well as .jpg still images.
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5. Managing 
Content

CoolSign Manager provides a rich set of features to help you organize and manage the 
content in your CoolSign network. You can use CoolSign Manager to import or update 
content, modify content properties like duration, transitions, scaling and volume, review play 
history and scheduling statistics, and even preview the content as it will appear on your 
CoolSign players.

Working with content
Content in CoolSign must be imported into the system before it can be scheduled or played 
on the CoolSign players connected to your network.

To import content into your CoolSign network:
• From the Content Manager, choose Actions > Import Content and select the content folder 

you wish to import.

The Content Import dialog shows the progress of any current and pending content imports.

If content already exists with the same name as the content you are importing, an alert dialog 
will ask you if you want to replace or rename the imported content.

Tip: You can continue working with CoolSign Manager while the import occurs in the background or 
you can queue up additional imports by repeating these steps.
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Tip: You can also import content folders by dragging and dropping them from the Windows desktop 
directly into the Content Manager data grid or onto the Content Manager icon. You can drag multiple 
folders at once or drag new folders one at a time.

Updating content

Once imported, the assets within your content are locked down and can no longer be 
modified from within the system. If you modify either the content script or the assets within 
your content, you must reimport to update the existing content. If the content you are 
updating has been scheduled, CoolSign will automatically update the content on those 
players where it has been scheduled, including transferring any required files.

Exporting content

You can export content that has been imported into CoolSign Manager if you need to modify 
the content externally or transfer it to another network. 

To export content from your CoolSign network:

1. In the Content Manager data grid, select one or more content items that you wish to export.

2. Choose Actions > Export Content.

3. Select a destination folder from the Browse for Folder dialog.

4. Click OK. A content export progress dialog will appear.

Tip: You should always backup your content externally from CoolSign in case you experience any 
issues that result in loss of data or corruption.

Deleting content

If you no longer plan to use a content item, you may choose to delete it from the network. 
Deleted content is immediately removed from any channels or playlists and ceases playback 
on all players where it is scheduled. 

WARNING!  Previous versions of CoolSign Manager provided a recycle bin from which you could 
recover deleted content. This functionality is no longer available in CoolSign Manager. Deleted 
content cannot be recovered. Be sure that you have a backup of your content outside of the sys-
tem. If you want to export your content from the system before deleting, refer to the above sec-
tion on Exporting Content.

To delete content:

1. In the Content Manager datagrid, select the content you want to delete. You can select mul-
tiple items.
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2. Do one of the following:

• Choose Edit > Delete.
• Right-click and choose Delete.
• Press the Delete key on your keyboard.

Using the Content Properties dialog
The Content Properties dialog allows you to modify certain properties of selected content and 
to view useful information about how your content is scheduled and how many times it has 
played.

To display the Content Properties dialog:

Do one of the following:

• Select the content item in the Content screen and choose Actions > Edit Content 
Properties.

• Double-click the content item.
• Right-click on the content item and choose Edit Content Properties.

Editing content properties

After importing, you may find it necessary to modify one or more properties of your content. 
Rather than having to change the content externally and reimport, you can adjust many of the 
content’s properties directly from the Content Properties dialog. 

Note: You can only modify properties of the content item itself. You cannot edit or change the 
individual assets used within the content. If you want to modify an asset (for example, change a bitmap 
or edit an MPEG-2 video), you must reimport the entire content item to replace the existing item in 
CoolSign.

To edit the properties of a content item:

1. From the Content Properties dialog, change one or more of the content properties.

2. Click OK or Apply Changes. Changes are immediately applied to the selected content and on 
any players where the content is scheduled.
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Note: Content is only updated on players that are currently online. If a player is offline, it will 
automatically receive any updates to modified content as soon as it comes back online.

In the Content Properties dialog, the General tab allows you to view and/or modify the 
following properties of the selected content:

Name—The content’s name is used wherever the content is referred to, including playlogs 
and scheduled items.

Version—Each time the content is modified or updated, the version number is 
incremented. 

Format—Displays the player format that this content was authored for. Content can only 
be scheduled in regions that match their format. This value cannot be modified.
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Resolution—Displays the pixel height and width at which the content was authored. 

Size—Displays the total size of the content including all its assets.

Duration—Use this property to adjust the length of time for which the content plays. If the 
content includes video or flash assets, setting the duration to less than the video’s duration 
will cut off the video playing. Setting the duration to longer than a video asset’s duration 
will cause the video to hold on the last frame for the remainder of the content play.

Volume Gain—Use volume gain to modify the overall volume level of all video, flash, or 
sound assets used in the content. The value can be between -100 and 100 with 0 being the 
normal, unmodified volume level of the assets. 

Note: You can adjust the overall volume of player from the Player Properties dialog. You only 
need to adjust the volume gain if you want to “normalize” the volume of a content item relative 
to the other content.

WARNING!  You can only control the volume of SWF files that are version 8 or older. 
With SWF version 9 files, it is not possible to control the player volume from CoolSign.

Transition—Allows you to set the effect that is used to transition from the previously 
playing content into the selected content. In general, transitions first change to the 
transition color and then into the next content item. (If the transition type is FadeToBG, 
Cut, or CrossFade, the color property is ignored.)

Note: If you are using frame-based synchronization (page 107), you cannot cross-fade content. 
Instead, choose the Fade or FadeToBG transition type.

Transition Length—Use to set the number of seconds in which the transition will occur.

Setting Content Resize settings

In the Content Properties dialog, you use the Content Resize settings to define how the 
content should be displayed on players. The options are as follows:

Scale content to fit—Scales content to fit the resolution of the player the content is 
scheduled on. If the aspect ratio of the player does not match the content’s aspect ratio, 
the content is stretched non-linearly to fill the player unless Preserve Aspect Ratio is 
checked.

Preserve aspect ratio—Forces scaled content to preserve its original aspect ratio when 
played on players with different resolutions and aspect ratios than that of the content. The 
behavior of this checkbox is further defined by the following radio buttons:

Crop edges of content—When scaling to fit, the content is scaled linearly until the smaller 
of the content’s width or height matches the smaller of the player’s width or height. This 
may result in pixels being cropped off the edge of the player.

Letterbox content—When scaling to fit, the content is scaled linearly until the larger of the 
content’s width or height fits into the player’s width or height. The empty area that 
remains will be black. 
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The following images show how a 320x240 MPEG-1 displayed on a 848x480 plasma screen 
would appear with the different available content resize settings:

Tip: As a general rule, you should turn on Scale content to fit display and turn off Preserve 
aspect ratio. This ensures that the content always fills the screen regardless of the resolution and 
aspect ratio of the display device you are using.

Setting content activation and expiration

You can use the content activation and expiration properties to globally control when content 
is enabled to play across all of your channels and players. 
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Content Activation

You can use content activation to set a date and time when the content should be enabled to 
start playing.

Tip: You can use content activation if you want to schedule some content immediately so it is 
transferred to your players but you don’t want it to start playing until a specific date and time. Content 
activation allows you to control the activation date globally across all channels and playlists, instead of 
within each individual schedule.

To set the activation date of content:

1. Click the Activates At radio button.

2. Click the Activation Date Editor to edit the activation date at which the content can start 
playing.

To set content to be active now:
• Click the Activates Now radio button.

Content Expiration

You can use content expiration to set a global date and time for your content to stop playing 
everywhere regardless of its scheduling properties. When content expires it is automatically 
removed from all channels and playlists across your network. 

To set the expiration date of content:

1. Click the Expires At radio button.

2. Click the Expiration Date Editor to edit the expiration date at which the content should stop 
playing.

To set content to never expire:
• Click the Expires Never radio button.

WARNING!  In CoolSign 4, expired content is not automatically deleted but is displayed in the Content 
Manager in red to indicate that it is expired. If you want to remove the expired content, you must man-
ually delete it.

Previewing content

You can preview your content as it will play back in a CoolSign player directly from the Content 
Properties dialog. 

To preview content:

In the Content Properties dialog, click the Preview Content button.
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Note: When you first preview a content item, the asset files required for that content are transferred 
from the CoolSign Network Controller and cached in a temporary folder in your CoolSign Manager 
installation directory.

WARNING!  Content preview is only supported on PCs that meet the minimum requirements for a 
CoolSign player. Older PCs or unsupported video cards may not be capable of content previewing.

Setting the thumbnail image for content

You can set the thumbnail image displayed in the Content Manager grid and in the Content 
Properties dialog when you are previewing the content.

To set the thumbnail for content:

1. In the Content Properties dialog, click the Preview Content button.

2. Use the preview content transport controls to pause the preview on the frame you want to 
use for your thumbnail. You can use the frame advance and rewind buttons to fine-tune the 
frame to use.

3. Click the Set Thumbnail to Current Frame button.

Adding comments to content

You can add comments to any content item if you want to track additional information about 
the content. When you add a comment, the user who entered the comment and a timestamp 
will be automatically added.

To add a comment:

Click the Add button beneath the comments grid and enter your comment into the field 
provided.

To remove a comment:

Select the comment in the comments grid and click the Remove button.

Viewing information about content
You can use the Content Properties dialog to view information about your content. For 
example, you can review where your content is scheduled, any issues that the content may be 
having, and retrieve play history reports for the content.

Viewing the assets used within content

You can view the names of the asset files that are part of a content item from the Assets tab of 
the Content Properties dialog.

To view the assets used within a content item:

From the Content Properties dialog, select the Assets tab.
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To edit the control script for a content item:

1. In the Assets tab of the Content Properties dialog, click the Edit Control Script button.

2. In the Edit Control Script dialog, make any desired changes to the control script XML.

3. Click OK to close the dialog.

4. Click OK or Apply Changes to save your changes.

Note: You should only attempt to edit the control script of content if you are familiar with hand-editing 
content scripts. Invalid content scripts will result in content errors and will prevent your content from 
being played.

Viewing where content is scheduled

You can quickly view all the channels and players where a selected piece of content is 
scheduled from the Schedule Info tab of the Content Properties dialog.

Viewing the status of scheduled content 

To view the status of a piece of content on all players where it is scheduled, select the 
Schedule Info tab of the Content Properties dialog.
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Retrieving play history for content

You can retrieve the play history of one or more selected content items from the Play History 
tab of the Content Properties dialog. Play history provides a summary of the number of times 
a piece of content has played on each player it is scheduled over a period of time.

NEED NEW SCREEN ABOVE--ATTRIBUTES

To retrieve the play history for content:

1. From the Play History tab of the Content Properties dialog, select the View Range for which 
you wish to retrieve the content’s play history. Alternatively, you can manually enter the 
From and To dates, using the date and time editors.

2. Set one or more of the following options:

• To include daily play summaries, check “Include day by day breakdown”.
• To only show plays that occurred while the site was open, check “Only show logs from 

during site business hours”. This option can also significantly increase the amount of time 
required to retrieve the logs.

Tip: For more information on sites and defining site business hours, see “Setting the hours for a 
site” on page 133.

• To show all the players on your network, including those on which the content didn’t even 
play, check “Show 0-play Players”.

3. Click the Retrieve Logs button.

Note: Retrieving playlogs for view ranges of over a week or for large networks can sometimes take a 
few minutes to complete. 
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To export the play history logs to a file:

1. Right-click on the column header of the Play History grid and choose Save Grid Data to File...

2. In the Export to File settings dialog, select the File format you would like to export to and set 
any available options.

3. Click OK.

To print the play history logs:

Right-click on the column header of the Play History grid and choose Print Grid...

Using the Attributes tab

You can define your own custom attributes for content if you want to track specific 
information with each content item. For example, you may want to add a Client field so you 
can track the name of the client within a media advertising network. Attribute fields can be 
displayed within your views in the Content Manager and used within searches or 
QuickSearches.

Note: Attributes can only be used to help organize and manage content within CoolSign Manager. You 
cannot access the user fields as dynamic data or to display within content playback. 
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To add an Attribute field to content:

1. From the Attributes tab on any Content Properties dialog, click the Define Attributes button.

2. In the subsequent Attributes dialog, click the Add button to open a blank Attribute Proper-
ties dialog.

3. Type a name for the new Attribute.

4. Set one or more of the following options:

• If you want to restrict the options available for input, click the Use picklist checkbox.
• Enter one or more lines of text into the PickList box. Each line of text will appear as an 

option in the picklist when editing a user field.

5. If you want to let users enter their own data in addition to being able to choose from the 
options in your picklist, click the Allow user to enter custom values checkbox.Click OK. The 
new Attribute will be added to all existing and new content.
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6. Managing 
Audio

In addition to the Content page, CoolSign Manager includes a specialized manager page for 
working with audio-only content. If you plan to use CoolSign to drive an audio-only player or 
create a special audio region on a player, you can use the Audio page to import and manage 
audio content. The Audio page lets you organize your audio content using the more intuitive 
categories of Artist, Title, and Album instead of a single content name.

Creating audio content 
Unlike standard visual content, you can create the audio content by importing supported 
audio files directly into the CoolSign Manager Audio page without needing to run them 
through the CoolSign Content Wizard or other tools. When importing an audio file, CoolSign 
Manager reads the MP3 ID3 tags embedded in the file and uses them to create the audio 
content in CoolSign.

Note: The Audio manager currently only supports MP3 files with ID3v1 tags. Certain applications 
(notably iTunes) only apply IDv2 tags, requiring you to use a third-party application to set the ID3v1 on 
the file.
 

To create audio content:

1. Choose Actions > Import Audio.

2. Select an MP3 file using the file browser dialog.

3. Click OK to import the MP3 and create audio content.
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Tip: You can also directly import MP3 files by dragging and dropping them from the desktop into the 
Audio page grid.

Editing audio content properties
You can edit the properties of audio content on the Audio Properties dialog.

To edit the properties of audio content:

1. To display the Audio Properties dialog, do one of the following:

• Select the Audio content in the Audio page and choose Actions > Edit Audio Properties.
• Double-click the Audio content in the Audio grid.
• Right-click the Audio content and choose Edit Audio Properties.

2. Review or change any of the following properties:

Filename—Displays the original audio filename imported into CoolSign Manager. You 
cannot modify the filename.
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Artist, Title, Album, Year—These properties are read from the ID3v1 tags embedded into 
the MP3 file at import. You can modify these properties as desired.

Duration—The amount of time that the audio content plays for. Entering a duration that is 
less than the actual length of the imported MP3 will truncate playback. Extending the 
duration beyond the length of the MP3 will play silence.

File Size—The disk space used by the imported MP3 file.

Volume Gain—Use volume gain to modify the overall volume level of all video, flash, or 
sound assets used in the content. The value can be between -100 and 100, with 0 being 
the normal, unmodified volume level of the assets. 

Note: You can adjust the overall volume of the player from the player properties dialog. You 
only need to adjust the volume gain if you want to “normalize” the volume of a content item 
relative to the other content.

WARNING!  You can only control the volume of SWF files that are version 8 or older. With SWF 
version 9 files, it is not possible to control the player volume from CoolSign.

Activation/Expiration Date—You can use the activation and expiration date to set when 
your audio content is able to play back in any channels or playlists. For more information, 
see “Setting content activation and expiration” on page 64.

3. Click OK or Apply Changes.

Viewing information about audio content
You can use the QuickSets, Schedule Info, and Play History tabs to view or retrieve additional 
information about how your audio content is organized, scheduled, and how often it has 
played. The use of these tabs is identical to the Content Properties dialog.

• For more information on managing QuickSets, see “Using QuickSets” on page 49.
• For more information on viewing content schedule info, see “Viewing where content is 

scheduled” on page 67.
• For more information on retrieving content play history, see “To retrieve the play history 

for content:” on page 68.

Scheduling and playing audio content
CoolSign doesn’t treat audio content any differently than standard content in how it can be 
scheduled, transferred or played back other than the fact that audio content does not display 
anything visually when played. 

All audio content is automatically created with the Audio format. You cannot modify the 
format of audio content. 

You can only schedule audio content into channels created with the Audio format and can 
only play back on players or regions set to the Audio format.
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7. About 
Scheduling

CoolSign Manager provides great flexibility in how you can schedule your content to appear 
on your CoolSign players. By using CoolSign channels and playlists, you can easily create 
schedules ranging from simple in-order playback to complicated nested schedules with 
weighted frequency and dynamic enabling expressions.

About channels

Channels are the primary tool for scheduling how content will play back on your players. 
Channels are programmed with schedule items that define when and how content will be 
played back. You can schedule individual content items to play in your channel or, for more 
complicated scheduling, you can add playlists, which are sub-schedules of content. Once your 
channel is programmed, you can “tune” as many players as desired to the channel and all the 
necessary content will automatically be downloaded to the player before the channel starts 
playing.

A great advantage of channels is that if you need to change what is playing on your players, 
you can just edit the channel once and all players tuned to that channel will automatically be 
updated. There is no limit to the number of channels that you can create.

Channels are managed from the Channels page of CoolSign Manager. For details, see 
“Managing Channels” on page 81.
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About playlists

Playlists are similar to channels except that they are limited to in-rotation items and players 
cannot be tuned directly to them. You can use playlists within channels to provide more 
flexible scheduling than you could otherwise accomplish with just a flat schedule. For 
example, you can use playlists to ensure that multiple content items always play back-to-back 
or to cycle through a set of content one at a time.

You can also use playlists to help manage regional or local schedules across large numbers of 
players and sites. For example, you might decide to create a “National” playlist and schedule it 
in all your channels across your CoolSign network. You can then update the “National” playlist 
once and all players in your network would be updated automatically as well. Playlists can be 
nested within other playlists for even more scheduling flexibility.

Playlists are managed from the Playlists page of CoolSign Manager.
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8. Managing 
Channels

Channels are the primary tool for scheduling how content will play back on your players. 
Channels allow you to centrally manage all the schedules for a player from one convenient 
page. Rather than scheduling content directly onto a player, you use channels to program how 
content should play and then tune a player to the channel. Multiple players can all be tuned to 
the same channel. If at any point you modify a channel by adding, editing, or removing 
scheduled items, any players that are tuned to that channel will automatically be updated 
with the changes. 

For more information on tuning players to channels, see “Tuning a player to a channel” on 
page 120.

Working with channels
You can use the Channels page of CoolSign Manager to create new channels, edit or delete 
existing channels, and to program content or playlists within channel.

To navigate to the Channels page:

• Click the Channels icon  in the navigation bar.

To create a new channel:

1. From the Channels page, do one of the following:

•  Choose Actions > New Channel
•  Right-click on the Channels Manager grid and choose New Channel

The Channel Properties dialog appears.

2. Enter a name for your new channel in the Name field.

3. Choose a format for your new channel from the Format combobox. Only content with the 
same format can be scheduled into the channel, and only players with the same format can 
tune to the channel. For example, you can only schedule portrait content into a portrait 
channel and only portrait players can be tuned to portrait channels.

Note: Once you add items to a channel, you will no longer be able to modify its format. If you need to 
change the format of a channel, delete any scheduled items first.

4. Add content items and/or playlists to the channel See “Adding items to a channel” on 
page 83.

5. Click OK.
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To edit an existing channel:

1. From the Channels page, do one of the following:

•  Select the channel and choose Actions > Edit Channel Properties.
•  Right-click the channel and choose Edit Channel Properties.
•  Double-click on the channel.

2. Change any available properties or add, edit, or remove scheduled items in the channel. See 
“Adding items to a channel” on page 83.

3. Click OK or Apply Changes. Any players tuned to this channel will automatically update to 
reflect changes made to the channel.

To delete a channel:

1. From the Channels page, do one of the following:

• Select the channel and choose Edit > Delete. 
• Right-click the channel and choose Delete.

You will be warned before attempting to delete any channels that are currently in use by a 
player.
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About the Channel Properties dialog
You can use the Channel Properties dialog to modify the properties of a channel and to 
manage the scheduled items programmed to play when a player is tuned to that channel. The 
Channel Properties dialog contains a collapsible schedule grid that lets you organize how your 
scheduled item will play and visualize the schedule. 

Adding items to a channel
When you add content or playlists to a channel, you can set properties that define how the 
scheduled item will play back in the channel including daypart scheduling, activation/
expiration dates, and enabling expressions.
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To add a scheduled item to a channel:

1. From the Channel Properties dialog, click Add In-Rotation Item. The Content Chooser dialog 
appears.

2. To add content to the channel, select a content item to add. You can select multiple items if 
you want to add more than one item at once with the same scheduled item settings.

3. To add a playlist to the channel, click the Playlists tab and select one or more playlists to add.

4. Click OK to close the Content Chooser dialog and open the Scheduled Items Properties dia-
log.

5. Set any scheduled items properties and the daypart schedule to define how the content or 
playlist will play within your channel. For more information, see “About scheduled items” on 
page 85.

6. Click OK.
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About scheduled items

You can use the Scheduled Item Properties dialog to define how an item will be played back in 
a channel, set advanced properties including activation/expiration date and enabling 
expression, and to override dynamic data bindings for that scheduled instance.

There are five ways that scheduled items can be played within a channel:

In-rotation (page 86)—This is the most common way to schedule content or playlists in a 
channel. A channel repeatedly plays its in-rotation items unless one of the specialized 
schedule items described below takes precedence. You can choose the order in which in-
rotation items are played back by setting the channel or playlist picker type. The in-rotation 
picker can be set to play back items in order, shuffled or randomly using a weighted 
frequency. Each in-rotation item can additionally be set with a daypart schedule that enables 
or disables the item during specific hours or days of the week and activation/expiration dates 
that define when the item should start and stop playing. 

Note: You can synchronize in-rotation content from multiple channels. For details, see page 103.

Recurring (page 88)—You can use this schedule type to schedule content to play at regular 
repeated intervals, for example, every 15 minutes or every hour. A recurring item can be set to 
either interrupt playing content when it’s time for it to play or to wait politely for the playing 
content to end before starting. Like In-rotation items, you can set a daypart schedule to only 
enable the recurring item during specific hours of the day.
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Timed (page 89)—When you want content to play once at a specific time on a specific date 
or day of week, you can use this schedule type. Like recurring items, timed items can be set to 
interrupt playing content at the play time if desired. 

Note: If you establish a schedule of synchronized in-rotation content (as described on page 103), be 
very careful when scheduling timed content. If the timed content interrupts a schedule of 
synchronized in-rotation content, the player may display a black pause before the scheduled content 
resumes play.

Triggered (page 90)—Content that is scheduled using the triggered type will only play 
when triggered via the CoolSign Manager trigger manager or an external data source.

Merged (Playlists only) (page 91)—Merged playlists treat the scheduled items of a playlist as 
if they were directly added to the channel. This allows you to take advantage of the 
organizational advantages of using playlists while retaining full flexibility for scheduling. The 
“Merged” schedule-type does not appear in the Scheduled-Type drop-down list of the 
Scheduled Item Properties dialog unless Playlist content is added.

Note: The “Add In-Rotation” button is used to initiate the addition of all schedule types noted above.

Adding an in-rotation scheduled item

In-rotation scheduled items are the most common way to add items to a channel. You can set 
a daypart schedule for in-rotation items as well as a frequency setting if the channel is using 
the Weighted Frequency picker. (See “Setting the in-rotation playback order” on page 87.)

To add an in-rotation scheduled item:

1. Follow the steps on page 83 to add a new scheduled item to the channel.
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2. In the Scheduled Item Properties dialog, select InRotation from the Scheduled Type box
.

3. If the channel is set to use the Weighted Frequency picker, you can set the relative frequency 
of the in-rotation item from 1 to 10. For more information on pickers, see “Setting the in-
rotation playback order” on page 87.

4. Define the times and days for which the scheduled item should be played. The blue cells of 
the schedule grid indicate that the item will be played in rotation with any other active 
scheduled items. The white cells indicate that the item will not play. For more information, 
see Chapter 19, Using Schedule Grids, on page 231.

5. Set any advanced properties for the scheduled item. For more information, see “Setting 
advanced schedule item properties” on page 92.

6. If you have selected dynamic content and want to override the data bindings for this sched-
uled item only, click the Dynamic Data tab. For more information, see “Overriding dynamic 
data settings” on page 127.

7. Click OK to add the scheduled item to the channel.

Setting the in-rotation playback order

To determine the order in which in-rotation scheduled items should play back within a 
channel, you can choose one of the following playback algorithms:

In Order—The default picker used for a new channel. Any active in-rotation items are played 
back in the order they appear in the Channel grid. 

Note: You can reorder scheduled items in the channel grid by clicking and dragging the item to a new 
position.
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Shuffled—Randomly shuffles all the in-rotation scheduled items and plays them back in the 
random order. All the items will play back before the list is shuffled again. This algorithm 
ensures that the same scheduled item never plays back to back.

Weighted Frequency—Uses a frequency value assigned to each scheduled item to determine 
which item should play next. Items with higher frequency will play more often than items with 
a lower frequency. The frequency value for a scheduled item represents its relative frequency 
when compared with other items in the channel.

Tip:  Due to the randomness inherent in the weighted frequency picker, it is impossible to predict 
exactly how often an item will play, but you can view an approximate estimate on the Scheduled Items 
Properties dialog.

Note:  When fewer than seven items are scheduled using the Weighted Frequency picker, the picker 
allows items with higher frequencies to play back to back to preserve the relative frequency ratios. If 
you want to ensure that weighted items never play back to back, you should use the Weighted 
Frequency 2.0-style picker. 

Weighted Frequency 2.0-style—Included for backwards compatibility with previous versions 
of CoolSign. The 2.0 Weighted Frequency picker is identical to the Weighted Frequency picker 
except that it will never let the same scheduled item play back to back. This can result in 
unexpected ordering when there are fewer than seven scheduled items, because it can be 
impossible to preserve the relative frequencies without playing an item back to back. For 
example, a channel where two items have a frequency of 1 and one item has a frequency of 10 
would need to play the frequency-10 item back to back multiple times to preserve to 10X 
frequency rating. 

To select the in-rotation playback order:
• Select the playback order type in the In-Rotation Items area of the Channel Properties 

dialog (page 83).

Adding a recurring scheduled item

Recurring scheduled items can be set to play back content on a repeating interval. You can set 
properties related to the recurring interval as well as a schedule of the times and days of the 
week for which the item is active.

To add a recurring scheduled item:

1. Follow the steps on page 83 to add an new scheduled item to the channel.
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2. In the Scheduled Item Properties dialog, select Recurring from the Scheduled Type box.
.

3. Define how often you want the scheduled item to repeat by setting the hours and minutes 
values.

Note: A recurring item will play after each repeat interval starting at midnight. If you want to offset 
when the recurring item plays, use the schedule grid to change the time when the item becomes 
active. For example, if you want an item to play every hour on the half hour, you would set the repeat 
interval to 1 hour and modify the schedule so that the item becomes active at 12:30am.

4. If you want the scheduled item to play exactly at the defined recurring interval, even if that 
would require interrupting content that is currently playing, check “Interrupt playing con-
tent”. Non-interrupting scheduled items will be queued to play immediately after the cur-
rently playing content.

5. Define the times and days for which the scheduled item should be played. The blue cells of 
the schedule grid indicate that the item is active and the white cells indicate that the item 
will not play. For more information, see Chapter 19, Using Schedule Grids, on page 231.

6. Set any advanced properties for the scheduled item. For more information, see “Setting 
advanced schedule item properties” on page 92.

7. If you have selected dynamic content and want to override the data bindings for this sched-
uled item only, click the Dynamic Data tab. For more information, see “Overriding dynamic 
data settings” on page 127.

8. Click OK to add the scheduled item to the channel.

Adding a timed scheduled item

Timed scheduled items play back once at each timed interval. You can set timed items to play 
back every day or on specific days at a defined time or once on a certain date and time. 
Because timed scheduled items inherently define when they play, you cannot set a daypart 
schedule for them.
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To add a timed scheduled item:

1. Follow the steps on page 83 to add an new scheduled item to the channel.

2. In the Scheduled Item Properties dialog, select Timed from the Scheduled Type box.

3. Click Add to define a time when the timed item should play. You can specify days of the 
week when the timed item should play or set an exact date and time when the timed item 
should play one time only.

Note: To add multiple times for a schedule item, click the Add button again.

4. If you want the scheduled item to play exactly at the defined time(s), even if that would 
require interrupting content that is currently playing, check “Interrupt playing content”. Non-
interrupting scheduled items will be queued to play immediately after the currently playing 
content.

5. Set any advanced properties for the scheduled item. For more information, see “Setting 
advanced schedule item properties” on page 92.

6. If you have selected dynamic content and want to override the data bindings for this sched-
uled item only, click the Dynamic Data tab. For more information, see “Overriding dynamic 
data settings” on page 127.

7. Click OK to add the scheduled item to the channel.

Adding a triggered scheduled item

Triggered scheduled items are played whenever the assigned trigger is fired via an external 
application or manually from the Manage Triggers dialog. You can select a trigger for the 
schedule item, along with specific times and days of the week when the item is active.
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To add a triggered scheduled item:

1. Follow the steps on page 83 to add a new scheduled item to the channel.

2. In the Scheduled Item Properties dialog, select Triggered from the Scheduled Type box.

3. Select a trigger in the Trigger combobox or click Create New Trigger. For more information 
on triggers, see Chapter 20, Managing Triggers, on page 235.

4. If you want the scheduled item to play immediately when it is triggered, even if that would 
require interrupting content that is currently playing, check Interrupt playing content. Non-
interrupting scheduled items will be queued to play immediately after the currently playing 
content.

5. Define the times and days for which the scheduled item can be triggered. The blue cells of 
the schedule grid indicate that the item is active and the white cells indicate that the item 
will not play. For more information, see Chapter 19, Using Schedule Grids, on page 231.

6. Set any advanced properties for the scheduled item. For more information, see “Setting 
advanced schedule item properties” on page 92.

7. If you have selected dynamic content and want to override the data bindings for this sched-
uled item only, click the Dynamic Data tab. For more information, see “Overriding dynamic 
data settings” on page 127.

8. Click OK to add the scheduled item to the channel.

Adding a merged scheduled item

Merged scheduled items are a special type of scheduled item that can only be used with 
playlists. A merged playlist schedule item treats the items in a playlist as if they had been 
added directly to the channel.

For example, you could create a “National” playlist and schedule it as merged within all of your 
channels. The items in the “National” playlist would play back as if scheduled directly within 
each channel except that you could update items centrally from within the playlist without 
having to edit each channel. 

For more information on playlists and scheduling strategies, see Chapter 9, Managing Playlists, 
on page 111.

To add a merged scheduled item:

1. Follow the steps on page 83 to add a new scheduled item to the channel remembering to 
select from the Playlists tab rather than the default Content tab of the Content Chooser.
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2. In the Scheduled Item Properties dialog, select Merged from the Scheduled Type box.

Note: Merged is only available as an option when you are adding a playlist to the channel. You cannot 
set the Merged scheduled type for content or audio.

3. Set any advanced properties for the scheduled item. For more information, see “Setting 
advanced schedule item properties” on page 92.

4. Click OK to add the scheduled item to the channel.

Setting advanced schedule item properties

You can set advanced properties for scheduled items from the Scheduled Item Properties 
dialog.

Setting scheduled item activation and expiration dates

If you want a scheduled item to start or stop playing at some future date and time, you can set 
the activation date and expiration date for the item. Items will not become active until their 
activation date and will be indicated with a Pending status. Items set with an expiration date 
will immediately stop playing at their expiration date and time. 

Note: Activation and expiration dates are evaluated based on the local time zone of the player. For this 
reason, expired scheduled items are not automatically deleted from a channel until 24 hours after the 
expiration date to ensure that the content continues to play in all timezones until the local expiration 
date is passed.

Tip: Activation and expiration dates for scheduled items are applied to the current channel only. If you 
want to globally activate or expire content everywhere that it is scheduled, you can set Content 
Activation and Expiration dates from the Content Properties dialog.

To set the activation date of a scheduled item:

1. Click the Activates At radio button.

2. Click the Activation Date Editor drop-down to edit the activation date at which the item can 
start playing.

To set a scheduled item to be active now:
• Click the Activates Now radio button.
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To set the expiration date of a scheduled item:

1. Click the Expires At radio button.

2. Click the Expiration Date Editor drop-down to edit the expiration date at which the item 
should stop playing.

To set a scheduled item to never expire:
• Click the Expires Never radio button.

Using enabling expressions

Enabling expressions can be used to dynamically control when a player’s content plays and 
under what conditions it plays. With this release, you can now use enabling expressions to tie 
into dynamic Data Tables, Player Attributes (formerly Node Attributes), Content Attributes and 
Site Properties to create complex behaviors not only from a player node level but also from a 
site-level. The following sources and data tables can be used to create these behaviors:

Player Attributes—(formerly called Node Attributes) Can be displayed within your views in 
the Content Manager and used within searches or QuickSearches. For more details, see “About 
attributes” on page 175 of the Coolsign Manager User Guide.

Content Attributes—Users create their own content attributes in user fields such as 
language, company regions, store departments, etc. These attributes are tied to a player’s 
content at the “site level” and can be used to track additional data about each site that is 
relevant to your business.

Site Properties—Contains geographic information (locations, addresses, etc.) For more 
details, see “Creating a new site” on page 103 of the Coolsign Manager User Guide.

Data Tables—Mini-databases with a structure that is flexible enough to allow you to store 
anything from a single piece of information to a complex table with dozens of fields and 
hundreds of records. For more details, see “About data tables” on page 123 of the Coolsign 
Manager User Guide.

Source Attributes are 
enclosed with [ ].

Data Table
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Note: The enabling expression is evaluated each time a scheduled item is “supposed” to play. If it 
evaluates to true, the scheduled item plays back as scheduled; otherwise, the item does not play. For 
example, if you have a data table that contains the local weather for a player, you could use an enabling 
expression to play back content for umbrellas only in case of rain.

Enabling expressions can only be used to enable/disable an item from playing back as it is scheduled. 
You can’t use enabling expressions to force items to play. To force items to play based on external data, 
see Chapter 20, Managing Triggers, on page 235.

Adding or editing an enabling expression:

1. Double click an item in a channel and open the Schedule Item Properties dialog.

2. Click the Enabling Expression tab.

Following is a basic enabling expression that you can set up to evaluate against "Rain" being in 
the "Condition" field of the data table "Weather." The intent is for the umbrella advertisement 
to play each time it rains.

Select Data Table 
“Weather”

Select the Condition 
“Equals”

“Rain” appears in the 
Value box.
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A more complex enabling expression can be setup as follows. In this case, a Player attribute 
“Language” is compared to a Content attribute “Language”. The intent is for an “English” player 
to play its content each time these two attributes match.

A simplier enabling expression for “Language” can also be setup. In this case, a Player attribute 
“Language” can be setup.

Two things to remember when setting up Player attributes and Content attributes:

• Player attributes defined at the player node level will always override Site-level 
attributes when used in enabling expressions.

• If a Player Attribute is undefined at the Player Node level, it inherits values defined at the 
Site level.

You can also setup an enabling expression for a conduit device much the same way. For 
example, if the conduit outside temperature value is <50 degress, than put sweaters into the 
player rotation. Or, if a conduit audience measurement shows more women than men, play 
the womens’ advertisements. For more details about conduit devices, see section 12 “Conduit 
Device Control”.

Player Attribute “Language”

Select the Condition 
“Equals”

Content Attribute “Lan-
guage”

Note that in this case the “Picklist” values have been 
automatically populated.

Player Attribute “Language”
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If desired, check “Use advanced editor” if you want to review the actual javascript used for the 
enabling expression or if you want to hand-edit the expression to add additional logic to the 
expression. For more information on accessing dynamic data through JavaScript expressions, 
see the Content Scripting technical documentation provided with your software.

Site Properties is another source that can be evaluated and can be setup much the same way 
as the Player attribute “Language” expression previously mentioned.

To clear an enabling expression:

Click the Clear Expression on the Enabling Expression tab.

Determining when a channel can start playing
When you tune a player to a new channel, CoolSign automatically starts transferring the 
content required by the channel down to the player. Depending on the speed of your network 
and the number and size of the content files required for the channel, this can take anywhere 
from a few seconds to hours. For each channel, you can decide if you want the player to start 
playing items in the channel as soon as they are available or if you want the player to continue 
playing the current channel (or black if there is no channel) until all the items have transferred.

To mark a channel to wait for all items before playing:
• On the Channel Properties dialog (page 83), check “Wait for all items before playing”.

Note that in this case the “Picklist” values have been 
automatically populated.
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Tip: You can review the transfer status of the items in a channel to a player from the Player Properties 
dialog or the Transfers tab of the Node Properties dialog for the player node.

Working with the channel grid
The channel grid on the Channel Properties dialog displays all of the items scheduled in the 
content. For organization purposes, each type of scheduled item is listed in its own collapsible 
area so you can easily view all types of items or just focus on the items you are interested in. 
The channel grid displays the most common properties of each scheduled item as well as a 
graphical timeline of the item’s schedule.

Using scheduled item collapsible areas

Each type of scheduled item has its own collapsible area in the channel grid. You can expand 
or collapse each area to view or hide the scheduled items. When you first open a Channel 
Properties dialog, only the collapsible areas with one or more scheduled items are expanded. 
The other areas are collapsed.

To expand a collapsed scheduled item type area:
• Click to expand a collapse area.

Tip: To automatically collapse any other open areas, hold down the Ctrl key while expanding an area.

To resize an open area:

1. Move the mouse to the area between the two areas you want to resize.

2. When the cursor changes to , click and drag vertically to resize the areas.
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Understanding the channel grid

To help you quickly identify the properties of scheduled items, the channel grid provides 
visual feedback in the form of icons, colors, and the graphical timeline. Depending on the 
properties of your scheduled items, you may see any of the following icons:

Active content items scheduled in the channel.

Active playlists scheduled in the channel.

Content that will become active in the future due to a scheduled item or content 
activation date being set.

Content that has expired due to a scheduled item or content expiration date being set.

Content that has been disabled by checking the Disable this scheduled item from playing 
on the Scheduled Item Properties dialog.

Indicates a scheduled item for which an enabling expression has been set.

Setting activation and expiration dates from the channel grid

You can set the activation and expiration date for a scheduled item without opening its 
Scheduled Item Properties dialog. To do so, the date directly in the grid.

To edit a scheduled item’s activation or expiration date:

1. Click the activation or expiration date in the Channels grid.

2. Select a new date and time to use for activation or expiration or click Activates Now or 
Expires Never to remove the activation or expiration date.

Note: If the scheduled content has an activation or expiration date set from the Content Properties 
dialog, the activation and expiration dates will appear in red. A content item’s activation and expiration 
dates always take precedent over a scheduled item’s. You cannot set the scheduled item’s activation or 
expiration date outside the range defined by the content, but you can set it later or earlier.

Editing content properties

You can open the Content Properties dialog for any content scheduled in your channel if you 
want to quickly view or edit settings for the content.

To edit content properties for a scheduled content item:
• Right-click on the scheduled item and choose Edit Content Properties.

Showing content thumbnails

You can view the thumbnails for content in your channel.
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To display content thumbnails in the channel grid:
• Right-click in any column header and choose Show Thumbnails.

Working with the timeline view
The graphical timeline in the channel grid visually displays when a scheduled item is active 
across a span of weeks. You can configure the timeline to show from one to eight weeks and to 
calculate the total loop duration of scheduled content. You can also directly modify a 
scheduled item’s activation and expiration dates by clicking and dragging within the timeline.

Understanding the timeline

The timeline indicates the active state of the content during the current week and for two to 
eight weeks into the future. 

The following colors and patterns are used to indicate the active state of an item:

Solid blue—Indicates that the schedule item is active during the displayed days for the entire 
day.

White—Indicates that the item is not active on this day due to an activation or expiration date 
on the item.

Blue/gray pattern—Represents the daypart schedule for an item.

Checkerboard—Indicates that a content item is not active on this day because activation or 
expiration dates were set on the item itself.

Yellow—Weeks for which a scheduled item’s daypart schedule has been overridden.

Selecting the displayed weeks

By default, the timeline view displays the current week along with the number of future weeks 
set in the View options menu. You can select other weeks to view the timeline.

Use these arrow buttons to move to the pre-
vious or next week.

Right-click the date to directly select a 
week to display.

Click the Options menu to set 
additional options to configure 
the timeline.

The checkerboard pattern indicates that the con-
tent is not active or has expired on these days.

Indicates that this week has an 
overridden daypart schedule.

You can drag the handles to 
change the activation/expira-
tion dates for an item.

This pattern represents 
the daypart schedule for 
the item.
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To change the visible week:

1. Right-click the week label to open the Week Selector Calendar.

2. Select a day in the week you want to display in the timeline.

To navigate to the next or previous week:
• Click the left or right arrows to navigate to the previous or next week.

To change the number of displayed weeks:

1. Click Options to open the View Options menu.

2. Set the number of visible weeks from 1 to 8.
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Viewing the loop duration

If you are interested in managing the total duration of the In-Rotation items scheduled in a 
channel, you can use the Loop Duration panel. You can check the total duration of all content 
scheduled in-rotation by day. You can also set a minimum and maximum loop duration to 
receive visual indication of when the duration of your loop exceeds or is under your settings.

To display the Loop Duration panel:

1. Click Options to open the View Options menu.

2. Check Show Loop Duration.

To set the Max Loop and Min Loop settings:

1. Click Loop Duration to open the Loop menu.

2. Set the minimum duration in seconds that you want your loop to play. If your loop length is 
less than this value, the Loop Duration panel will display a yellow warning color.

3. Set the maximum duration in seconds that you want your loop to play. If your loop length is 
greater than this value, the Loop Duration panel will display a red warning color.

Click to open the Loop 
menu.

Yellow indicates that the total 
loop length is less than the mini-
mum set in the loop menu.

Blue indicates that the total loop 
length is within the min and max 
set in the loop menu.

Red indicates that the total loop 
length is longer than the maximum 
set in the loop menu.
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Cutting, copying, and pasting scheduled items
You can cut, copy, and paste scheduled items to different channels or you can copy just the 
schedule properties from a scheduled item and apply it to another scheduled item. When you 
copy and paste a scheduled item, you are duplicating the entire scheduled item including the 
content or playlist that is scheduled. When you just copy an item’s schedule properties, you 
are only copying the settings for the scheduled item and can then apply those settings to 
another scheduled item without changing the content or playlist that is scheduled.

To cut or copy a scheduled item:

Select the scheduled item and do one of the following:

• Enter Ctrl-C to copy or Ctrl-X to cut.
• Right-click and choose Cut or Copy.

To paste a scheduled item:

1. Open a Channel Properties dialog.

2. Click within the channel grid to give focus to the grid.

3. Enter Ctrl-P or right-click and choose Paste.

To copy the schedule properties from a scheduled item:
• Right-click on the scheduled item and choose Copy Item’s Schedule Properties.

To apply copied schedule properties to a scheduled item:
• Right-click on a scheduled item and choose Paste Into Item’s Schedule Properties.

Overriding playlist scheduled items
You can override the properties of the items within a playlist scheduled within a channel. 
Playlist overrides are applied only for the channel in which you create the override and not 
anywhere else the playlist is used.

For more information on overriding scheduled items, see“Overriding channels” on page 125.

Reviewing where a channel is used
You can quickly view which players have been tuned to a channel from the Players tab of the 
Channel Properties dialog.

For details, see “Tuning a player to a channel” on page 120.
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Synchronizing channels
You use synchronize two or more channels in independent regions or outputs on a single 
Player Node so that the timelines of the content pieces play at the same rate. For example, you 
might want to play two or more pieces of video simultaneously on separate screens. 

Only In-Rotation items in a channel can be synchronized.

To create synchronized channels:

1. Ensure that each channel adheres to the following rules:

• Items must have the same activation and expiration time.
• Items must have the same day part.
• Items cannot use enabling expressions.
• For playlist items, if the playback order type is 'Play One', all items in the playlist must have 

the same duration.
• If an item contains dynamic content, the dynamic content must be bound to a non-empty 

data source.

2. In the Channel Properties dialog (page 83), select the Advanced tab.

3. Set the synchronization type.

Frame-Based—Apply frame-based synchronization to video content. See page 107.

Schedule-Based—Do not apply frame-based synchronization to video content. Select this 
type if your machine cannot support the speed required for frame-based synchronization. 

Note: For synchronized channels that were defined with CoolSign Manager v4.0, you must explicitly 
specify frame-based synchronization in the Channel Properties dialog. Otherwise, players will (by 
default) apply schedule-based synchronization to the video content on those channels.
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To compare synchronized channels:

1. Create at least two synchronized channels, as described above.

2. Right-click on a synchronized channel, then select Compare Synchronized Channels from 
the popup menu.

3. The Channel Selector dialog opens and displays a list of all other synchronized channels. 
Select one or more channels that you wish to compare, then click OK.

Note: Alternatively, if you select multiple synchronized channels and then right-click, selecting 
Compare Synchronized Channels (from the popup menu) opens the Synchronization Status dialog 
directly. 
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4. The Schedule Synchronization Status dialog is displayed.

This dialog shows each synchronized channel, along with the names of its in-rotation 
schedule items. In the timeline, each rectangle represents a schedule item; the different 
colors simply serve to separate adjacent items. The length of a rectangle represents the 
duration of the item, which is also displayed to the left of the timeline.

Note: You can also synchronize channels whose in-rotation items include playlists. For details, see 
“Viewing synchronized playlists” on page 106.

In addition to the information displayed here, you can use the View pull-down menu to 
select Detailed View, which displays the name of the content item in each rectangle.

At the top left of the dialog, a status icon and label indicate the synchronization status of 
each channel: OK (all rules are met) or Error. When the status is “Error”, you can double-click 
on the status label (or right-click on the channel) to display a list of violated rules.

Note: If the timeline contains two adjacent rectangles in the same color, one of the following 
conditions may be present:

•There is a schedule item of duration 0 between the two rectangles.
•There is a disabled schedule item between the two rectangles.
•One or both of the rectangles represents a playlist item.
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Channels must have the same total duration (total duration refers to the total length of all in-
rotation non-disabled schedule item of a synchronized channel). If necessary, edit the 
duration of one or more synchronized channels, as described below.

To edit the duration of content:

1. Double-click on a rectangle in the timeline or on the name of a schedule item. (Alternatively, 
right-click on the item.)

2. From the popup menu, select Edit Content Properties. 

3. Change the duration in the Content Properties dialog (page 61).

Note: Alternatively, you can edit the duration in the Synchronization Status dialog. To do so, place the 
cursor on the right edge of a rectangle, then drag the edge horizontally. This sets the duration of the 
selected content to the nearest whole second, which is not nearly as precise as using the Content 
Properties dialog. While dragging a schedule item on the timeline, all items containing the same piece 
of content will be changed.

4. To save the edited duration, click Apply Changes or OK.

If all synchronized channels now have the same duration, and all other rules are met, the 
dialog displays the status “Ok”.

Viewing synchronized playlists

You can switch between content view and playlist view in the Synchronization Status dialog. 

• To display the playlist as a single shaded rectangle, right-click on a piece of content inside 
a playlist on the timeline, then choose Show Playlist. 

• To display the playlist’s elements separately, right-click on the playlist, then choose Show 
Content.

You cannot edit a playlist’s duration, which is calculated automatically. If the duration is too 
short, you can only display the playlist, not the individual content elements.
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If a playlist is set to Play One Item (page 113), the timeline only displays the playlist as a single 
item. The displayed duration is the average duration of all schedule items in the playlist. When 
a playlist contains items that don’t all have the same duration, it is displayed in red. To display 
information about the error condition, right-click on the playlist and then click Show Error.

If a playlist is set to Play All Items, the timeline includes all of the playlist’s items. 

Using the right-click popup menu

If you right-click on a channel or playlist in the Synchronization Status dialog, you can select 
the following actions from the popup menu:

• Edit Channel / Playlist Properties—Choose this option to edit the properties of the 
selected channel or playlist.

• Remove Enabling Expression—You cannot use an enabling expression on synchronized 
content items. To remove an item’s enabling expression, select the item, then right-click 
and choose this popup menu option. 

• Use Same Activation and Expiration Time—Apply the selected schedule item’s activation 
and expiration times to all other items of all channels displayed in the dialog.

Note: Be careful to choose the one item in the Synchronization Status dialog that has the 
activation/expiration dates that you want to apply to all other items.

• Use Same Schedule—Apply the selected schedule item’s schedule to all other items of all 
channels displayed in the dialog. You can select this item to repair synchronization errors.

Note: Be careful to choose the one item in the Synchronization Status dialog that has the schedule 
that you want to apply to all other items.

If the same content is included in multiple synchronized channels, any change to the content 
in one channel also affects the other channel(s). That is, changes are reflected in all displayed 
instances of the content (within the Synchronization Status dialog).

Frame-based synchronization

CoolSign applies frame-based synchronization to video content. In this way, you can combine 
multiple displays to create video walls that hand off content cleanly from one display to the 
next. 

Note: Frame-based synchronization is only available for video content. You cannot apply this to audio 
or to other frame-based assets, such as Flash. If any of your content elements are Flash, they won’t be 
synchronized frame by frame.
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Note the following limitations:

• You can only apply frame-based synchronization to videos that are playing on the same 
machine.

• Video cards are limited to four heads.
• With frame-based synchronization, you cannot cross-fade content. You must select an 

alternate transition type (page 63).

If you synchronize a schedule, CoolSign Manager will frame-synchronize the video.

Multi-player frame-based synchronization

In order for multi-player frame synchronization to work successfully, all machines must be able 
to communicate through UDP broadcast. (The master time server sends UDP pulses to other 
machines.)

You can override default settings to control multi-player synchronization explicitly. In the 
Configure Advanced Properties dialog (page 222), select the Software Configuration tab and 
open the AdPlayer settings. 

TimeSyncMasterIP—CoolSign uses an internal "election" algorithm to determine which 
computer serves as master for purposes of time synchronization. (Of course, all computers in 
the systems must be running content that is compatible so that channels can be synchronized 
properly.)

If you want to manually configure the system to ensure that a particular computer is master, 
set the TimeSyncMasterIP value on the master computer to its own IP address. On all other 
computers, set this value to the IP address of the time synchronization master.

TimeSyncPort—If you want to run multiple synchronization groups in a single room, you can 
specify a unique UDP time synchronization port for each group. This allows you to prevent 
anomalies that might result from incompatible channels attempting to synchronize. 

For example, you might have one group of players that are synchronizing channels A and B 
and a second group that is synchronizing channels C and D. To synchronize these groups 
independently, you can set the TimeSyncPort value for all computers in the two groups to 
14877 and 14879, respectively. 

To avoid potential conflicts with other settings, we recommend that you select a TimeSyncPort 
value of 10000 or greater.

TimeSyncSingleBox—If you want to explicitly remove a machine from multi-player frame 
synchronization, you can set TimeSyncSingleBox to True (the default). For example, you might 
do this for a single computer that has frame-based synchronization channels assigned with 
multiple outputs. When this value is True, the machine will not take part in CoolSign network 
communications; it will not listen for UDP time packets, nor will it send packets. 

In order for the computer to take part in multi-player frame synchronization, this value must 
be False.
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TimeSyncTTL—This setting determines the number of router hops that a network packet is 
allowed to make. We recommend that you accept the default (1).
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9. Managing 
Playlists

Playlists add additional flexibility when programming your channels by providing the 
capability to create “sub-schedules” within the channel’s schedule. You can also use playlists to 
help in “localizing” your schedules across multiple sites and players. Playlists are similar to 
channels with the following differences:

• You can only add In-Rotation scheduled items to a playlist.
• You can’t tune a player to a playlist. You must schedule a playlist within a channel.
• Playlists can be scheduled within other playlists.

Working with playlists
You can manage the playlists in your network from the Playlists manager page of CoolSign 
Manager. From the Playlists page, you can create new playlists, edit or delete existing playlists, 
and program content within your playlists.

To navigate to the Playlists page:

Click the Playlists icon in the navigation bar.

To create a new playlist:

1. From the Playlists page, do one of the following:

• Choose Actions > Create New PlayList.
• Right-click on the PlayList Manager grid and choose Create New PlayList

The Playlist Properties dialog appears.

2. In the Name field, enter a name for your new playlist.

3. Choose a format for your new playlist from the Format combobox. Only content with the 
same format can be scheduled into the playlist, and only channels with the same format can 
schedule the playlist. 

Note: Once you add items to a playlist, you can no longer modify its format. If you need to change the 
format of a playlist, delete any scheduled items first.

4. Add content items and/or other playlists to the playlist See “About the Playlist Properties dia-
log” on page 112.

5. Click OK.
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To edit an existing Playlist:

1. From the PlayList page, do one of the following to display the PlayList Properties dialog:

• Select the channel and choose Actions > Edit PlayList Properties.
• Right-click the channel and choose Edit PlayList Properties.
• Double-click on the playlist.

2. In the Playlist Properties dialog, change any available properties or add, edit, or remove 
scheduled items in the channel. See “About the Playlist Properties dialog” on page 112.

3. Click OK or Apply Changes. Any channels using this playlist will automatically update to 
reflect the changes.

To delete a playlist:
• Select the playlist and choose Edit > Delete. 

About the Playlist Properties dialog
You can use the Playlist Properties dialog to set or modify the properties of a playlist, add 
scheduled items to the playlist, and review which channels currently use the playlist. The 
Playlist Properties dialog is very similar to the Channel Properties dialog.
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Adding items to a playlist
The process for adding items to a playlist is identical to adding items to a channel except that 
you can only add In-Rotation scheduled items.

For more information on adding items to a channel, see “Adding items to a channel” on 
page 83.

Scheduling a playlist in a channel
Playlists can be scheduled into a channel (or other playlists) with all the same properties as a 
piece of content. You can schedule a playlist as In-rotation, Recurring, Timed, or Triggered. 
Playlists can have daypart schedules, activation/expiration dates, and enabling expressions 
just like content. However, when it comes time for a playlist to “play”, the channel lets the 
playlist pick which content or playlist should play, based on the items scheduled within the 
playlist and its own playback order settings.

Determining how a playlist plays

Just as with a channel, you can set the playback order for a playlist using the Playback order 
combobox. For more information on setting playback order, see “Setting the in-rotation 
playback order” on page 87.

Additionally, you can define whether the playlist should just play one item or all the items 
each time it is picked to play by its parent channel. 

Play One Item—When a playlist is set to Play One Item, it will play one item picked from its 
scheduled items. After playing the one item, it will return control to the parent channel or 
playlist.
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Play All Items—When a playlist is set to Play All Items, it will play all of its scheduled items 
before returning control to the parent channel or playlist.

About merged playlists
In addition to the four standard types of scheduled items, you can also schedule a playlist as 
merged within a channel. When a playlist is merged with a channel, the items within the 
playlist are treated just as if they were added directly to the parent channel. The parent 
channel selects scheduled items to play using both the scheduled item added directly to the 
channel and the items within the merged playlist. This feature allows you to manage sub-
sections of a channel separately and share them across multiple channels. 

Note: The playback order settings for a playlist are ignored when the playlist is scheduled as merged.

Localizing schedules
If your network contains a large number of sites or players, you may find that, while each 
player or site has some unique content playing on it, there is also a large amount of content 
that should be played across all the sites as well. You can use playlists to optimize your 
schedules so you can manage a large number of channels across a large number of players but 
still easily add content to the entire set or a subset of channels. 
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For example, if you are using CoolSign for a national advertising network, you may have 
national content that needs to play across your entire network, regional content that only 
plays on the West Coast, and specific content that plays at each site. By using merged playlists, 
you can build up channels for each player or site that can contain both the player-specific 
content items as well as a National and/or Regional merged playlist you have defined. By 
scheduling the National playlist into every channel used by every player, you can now quickly 
add or remove scheduled items from every player by just editing the National Playlist once. 

Synchronizing channels
You use synchronize two or more channels in independent regions or outputs on a single 
Player Node so that the timelines of the playlists and content pieces play at the same rate. For 
details, see “Synchronizing channels” on page 103.
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10. Managing 
Players

The Players page of CoolSign Manager lets you view all the CoolSign players connected to 
your network. You can do any of the following on the Players page:

• Tune a player to a channel.
• Review both detailed and rollup play history for a player.
• Set a schedule for the volume level of a player.
• Remotely configure the player, including defining multiple regions and display control.
• View the current status of both the player and any displays connected to the player.
• View the current content that is now playing on the player.
• Organize the players by geographic distribution, using the Sites panel.
• Create QuickSets and QuickSearches to filter which players are visible in the grid.
• Force content to play immediately on the player.

About players and channels
CoolSign uses a channel metaphor for scheduling content to play back on your players. You 
create channels and then program content and playlists within each channel. Once your 
channels are designed, you can then tune players to that channel. 

Once you tune a player to a channel, CoolSign automatically takes care of everything required 
to distribute the content, playlists, and data tables to the player. CoolSign checks to see which 
files need to be transferred and immediately starts sending them across your network to each 
player. Depending on the settings of the channel, items in the channel can start playing as 
soon as they are available, or the player can wait for all the items in the channel to be available 
before switching to the channel.

If, at any point, you modify a channel by adding new scheduled items, editing existing 
scheduled items, or removing items, those changes are automatically distributed to any 
players tuned to that channel. If a player happens to be offline when the changes are made, 
CoolSign will distribute the changes as soon as the player reconnects to the network.

Note: While each player can only be tuned to a single channel at a time, any number of players can be 
tuned to the same channel. This enables you to just update the channel and automatically have 
changes applied to all the players tuned to that channel automatically.

For more information on working with channels, see “Managing Channels” on page 81.
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Player Lifecycle Management
During its life cycle, a CoolSign player can operate in three possible modes:  active, staging, 
and retired.   Each mode has its own set of possible actions and constraints. This section 
describes each of the three modes.

In addition, this section describes several related actions: defining virtual player nodes, 
replicating the profile of an existing player to one or more additional players, and migrating a 
player's identity to replace another player's existing profile.

For details, see section “The life cycle of a CoolSign player” on page 178 of the Coolsign 
Manager User Guide.

Active Mode

By default, all CoolSign players are in active mode.  You can use CoolSign Manager to reassign 
a player to either staging or retired mode.

Staging Mode

During pre-production, you can place a player node into staging mode to ensure that it is 
properly configured before you put it into service.  In staging mode, the node's functionality is 
similar to that of an active node, but with several differences:  a staging mode does not 
contribute to network status calculations, generate alerts, or generate event logs (in the Node 
Properties dialog) or play logs (in the Player Properties dialog).

Retired Mode

If you need to decommission a player - that is, put it offline permanently - you can place the 
player into retired mode.  In retired mode, you can retrieve play logs or add comments, but 
you can no longer use the player to display CoolSign content, modify the logs, or perform 
other actions.

You cannot retire a node that is online; you must first take it offline, and only then can you 
retire the node.

Retiring a player is permanent. Once you place a player into retired mode, you cannot 
subsequently activate it again.

Virtual Players
To simplify the process of installing players on your CoolSign network, you can create one or 
more virtual players before actually deploying the physical player node. When the 
corresponding physical player node is subsequently deployed, it automatically inherits the 
settings that you have established for the virtual player. You can then use CoolSign Manager 
to continue configuring the player.

Virtual players do not contribute to network status calculations or generate event logs (in the 
Node Properties dialog) or play logs (in the Player Properties dialog).
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Replicating Players
Alternatively, you can replicate the configuration of an existing player node to one or more 
virtual players. When you subsequently deploy the physical player nodes, they automatically 
inherit their properties from the previously existing player node, rather than assuming default 
properties.

Migrating a Player's Identity
If a player node on your CoolSign network becomes disabled, you can install a new player 
node and then migrate the disabled player's properties—its identity—to the new node. 
During migration, the new player assumes the existing player's database records, security 
settings, schedules, play logs, and other historical data.

About the Player Properties dialog
You can use the Player Properties dialog to tune a player to a channel, review play history, and 
schedule volume control.

To edit the properties of a player:

Do one of the following:

• Double-click on the player in the grid.
• Select one or more players and choose Actions > Edit Player Properties or right-click and 

choose Edit Player Properties.
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Tuning a player to a channel
You can use the Player Properties dialog to tune a player to the channel it should use to play 
back content. The Player Properties dialog displays the currently tuned channel, using the 
same grid as appears on the Channel Properties dialog. 

For more information on working with channels and the channel schedule grid, see “About 
Scheduling” on page 79.

To tune a player to a channel:

1. Select a new channel from the Tune to Channel combobox. The channel grid is updated to 
reflect the new channel.

2. Click OK or Apply Changes. Any needed files will immediately begin transferring to the 
player.

Note: To tune multiple players to the same channel at the same time, select multiple players before 
opening the Player Properties dialog.

Reviewing a channel before tuning

Before you commit to tuning a player to a channel, you can see what the channel contains as 
well as which content items in the channel will need to be transferred to the player before 
they can play.

The status of each item in the proposed schedule can be either of the following:

 Available—The content item is already available on the local player hard disk and 
will not require any transfer to play.

Transfer required—The content must be transferred to the player 
before this item can be played. If the channel is marked as “Wait for all items before playing”, 
the player will not switch to the new channel until all needed content has been transferred to 
the player.

Note: All content in a tuned channel will be transferred to a player regardless whether it is currently 
active or pending activation due to the setting of a future activation date on the content or schedule 
item. This feature allows you to “stage” content on the player at the time you tune it so that you can be 
assured that the content is available when it comes time for it to play.

Viewing transfer status of items to a player

When you tune a player to a channel, all of the content, playlists, data tables, and files required 
to play that channel will automatically start transferring to the player. If, at any point, you 
modify either the channel or any content or playlists included in the channel, any changes will 
also be automatically transferred to the player for you. 

The status of each transferring item can be any of the following:
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Checking—A transfer has not yet started and the system is checking to see if it is 
necessary to transfer content to the player.

The transfer bar displays the current progress of a transfer to a player. The yellow 
portion of the bar indicates that data is still being transferred. The green portion indicates that 
all the files required for this content have been transferred. The transfer bar takes into account 
each hop that data must travel to reach a player (i.e., Network Controller –> Transfer Server –> 
Player) and displays a white vertical line for each hop.

An all-green transfer bar indicates that all necessary files for the content have 
been transferred to the player but that the content has not been loaded yet. You may see this 
status temporarily when the channel is marked to “Wait for all items to transfer before playing” 
or when there are additional files required for the content to play, for example, data tables 
with imported media files that have not yet completed transfer.

During the transfer, the Player Properties dialog shows the progress of the entire transfer 
required for the player:

Viewing the status of scheduled items on a player

Once all the necessary files required to play back content have been transferred to the player, 
the content will be loaded and should start playing back as scheduled. There are a number of 
reasons why content that has been scheduled and transferred to a player might not be 
actively playing. Once a content item has been transferred to the player and loaded, you can 
review its current status in the status column of the Player Properties dialog.

The status of each loaded item can be any of the following:

Ok—The content is loaded and should be playing back as scheduled.

Ok (Pending)—The content is loaded but is pending a future activation date, 
either set in the schedule item or the content.

Ok (Expired)—The content is loaded but has expired due to a past expiration date 
set in the schedule item or content. Expired items are automatically deleted from a channel 
after 24 hours.

Inactive—The schedule item has been disabled from the Schedule Item Properties 
dialog.

Error—A problem occurred while the content was playing back. The status includes 
additional information about the type of error and the version of the content which is playing. 
For more information on content errors, see “Troubleshooting display errors” on page 257.

Tip: If the status column is not wide enough to see the entire error status message, you can hover the 
mouse over the column to see a tooltip which displays the full contents of the field.

Offline—The entire player is currently offline.
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Viewing channel synchronization status

As described in Chapter 8, Managing Channels, you can use synchronize two or more channels 
in independent regions or outputs on a single Player Node so that the timelines of the content 
pieces play at the same rate. 

The Schedule Synchronization Status dialog shows all synchronized channels assigned to the 
selectetd player node, along with the names of the in-rotation schedule items on each 
channel. In this dialog, you can view the schedule items within the timeline and adjust the 
duration of content items. 

To view the Schedule Synchronization Status dialog, click View synchronization... from the 
Player Properties dialog (page 119).

Modifying channels
While you will usually create and edit channels from the Channels page, the Player Properties 
dialog provides some shortcuts to help you manage the available channels.

Creating a new channel

You can create a new blank channel directly from the Player Properties dialog and tune the 
player to it in one step. 

To create a new channel:

1. Click New Channel to open a new Channel Properties dialog.

2. Enter a name for the new channel and add schedule items as desired. For more information 
on working with channels, see “About Scheduling” on page 79.

3. Click OK. 

Editing the currently tuned channel

If you want to make changes to the currently tuned channel, you can do so directly from the 
Player Properties dialog without having to close the dialog and navigate to the Channels 
page.

Note: Changes you make to a channel will be applied to every player that is tuned to that channel. If 
you want to make changes to a channel for the current player only, refer to “Overriding channels” on 
page 125.

To edit the current channel:

1. Click Edit Channel to open a Channel Properties dialog for the currently tuned channel.

2. Make any desired changes to the channel.

3. Click OK. Any changes made to the channel will automatically start transferring to the player.
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Viewing play logs
You can retrieve the play history for a specific piece of content from the Content Properties 
dialog (see “Retrieving play history for content” on page 68) but if you want to review all of the 
content that played on a player, you can use the PlayLogs tab of the Player Properties dialog.

Viewing play summaries for a player

You can retrieve rolled-up summaries of all the content that has played on a player or set of 
players across any time range. Each content item that has played during the defined view 
range will be displayed with the total number of times it has played and the percentage of 
total plays of all played content.

To view the playlog summary:

1. In the PlayLogs tab, select the View Range for which you would like to retrieve playlogs or 
manually enter a From and To date.

2. To only include plays that occurred while the site this player is in was scheduled to be open, 
check Only show logs from during site open hours.

WARNING!  Showing logs from during open hours can take a significantly longer time to load. You can 
decrease the time required to retrieve the logs by setting a shorter view range.

3. Click Retrieve Logs.

Viewing detailed play logs for a player

In certain situations, you may want to retrieve the detailed logs for each player to review the 
exact time and reason that each piece of content played. If the content is enabled to log data 
slots, you can even view the state of any dynamic data fields at each time the content played.

For more information on enabling content to log dynamic data, see “Enabling data slot 
logging” on page 73.

To view the detailed playlogs:

1. Select the View Range for which you want to retrieve detailed playlogs or manually enter a 
From and To date.

2. Click Retrieve Logs.

Printing and exporting logs

Once you have retrieved playlogs for a player, you can print or export the logs to a file.

To print playlogs:
• Right-click on any column header and choose Print Grid.
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To export playlogs:
• Right-click on any column header and choose Save Grid Data to File.

Tip: For more information on working with grids, see “About the data grid” on page 43.

Controlling player volume
You can use the Sound Control tab of the Player Properties dialog to directly set or schedule 
the overall volume of a player. The player volume settings are applied globally to all content 
that plays. If you want to adjust an individual content item’s volume relative to other content 
being played, see “Using the Content Properties dialog” on page 61.

WARNING!  You can only control the volume of SWF files that are version 8 or older. With SWF version 9 
files, it is not possible to control the player volume.

To directly set the volume of a player:

1. Click the Set Volume radio button.

2. Enter a volume for the player from 0 to 100, with 0 being no audio and 100 being the maxi-
mum volume.

Note: Setting the volume on a player volume is equivalent to setting the Master Volume in the 
Windows Mixer. The Wave Volume in the Windows Mixer will always be set to the maximum.

To schedule volume on a player:

1. Click the Set Volume according to Schedule radio button.

2. Do one of the following:

• Click or drag a range of cells to toggle the volume on and off for the selected time.
• Right-click on a cell or range of cells to set a specific volume level for the selected time.

For more information on using schedule grids, see Chapter 19, Using Schedule Grids, on 
page 231.



Managing Players

CoolSign v4.5  CoolSign Manager User Guide � 125

Overriding channels

Overriding a channel is an advanced feature that provides added flexibility when scheduling 
content to play back on a player. Normally, tuning multiple players to the same channel will 
result in each player playing back the channel as it was programmed in the Channel Properties 
dialog. However, in some cases, you may want to make a small change to a channel on a 
specific player without creating an entirely new channel. For this situation, you can override 
certain properties of the scheduled items in a channel and apply them to a single player only.

Note: Overridden items are indicated in blue italic type in the channel grid.

WARNING!  Channel overriding should be used sparingly, as it can cause confusion in troubleshooting 
player issues and unexpected results when editing a channel that has been overridden in one or more 
players. In most cases, you should be able to achieve your scheduling goals using other mechanisms 
available like playlists or enabling expressions.
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To override the properties of a scheduled item:

1. On the Channel tab, do one of the following:

• Right-click on the scheduled item and choose Override Item.
• Double-click on the scheduled item.

2. On the Override Schedule Item Properties dialog, override any changes to the base schedule 
item. You can override the following:

• The daypart schedule for the item.
• The enabling expression for the item.
• Disable the item from playing.

Note: You cannot change the base scheduled type of an item or change the activation or 
expiration dates.

3. Click OK.
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To clear an override:
• Right-click the overridden item and choose Clear Override.

Overriding dynamic data settings

Normally, when you schedule dynamic content into a channel, the content will play back 
using whatever data table bindings set during import of the content or from the Content 
Properties dialog. If you want to change which dynamic data table a content item uses for a 
specific player or channel without needing to duplicate the entire content item, you can 
override the bindings from the Scheduled Item Properties dialog.

To override data bindings at schedule time:

1. Do one of the following:

• Right-click on the scheduled item and choose Override Item.
• Double-click on the scheduled item.

2. From the Scheduled Item Properties dialog, click to display the Dynamic Data tab.

3. If you want to override a binding, select a new data table to use for this scheduled item only. 

4. The dynamic data tab allows you to edit the data in a data table directly from the dialog. You 
can add or delete rows and edit data as needed.

Note: Edits to a data table are applied globally to the data table everywhere that it is used. You cannot 
override the values in a data table for a scheduled item—you can only override which data table is 
used. For more information on localizing data, see “Localizing data” on page 165.

5. If you want to override the master expression prescript, click Edit Prescript Expression.

6. Click OK.

For more information on dynamic data and content binding, see Chapter 14, About Dynamic 
Data, on page 161.

Playing content on demand (Play Content Now)
If necessary, you can direct the CoolSign Manager to play content on demand, even if that 
would require interrupting content that is currently playing.

To play content on demand:

1. In the Players page, select the player/region where you want to run the content.

2. Right-click Play Content Now.
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3. In the Content dialog, select the content that you want to play immediately.

• If content is listed in black, it is available to play immediately.
• If content is listed in red, it is not currently available on the Player node, and begins 

playing after the content has been transferred to the Player.

Note: Clicking Download Content, Play Next, or Play Now causes the selected content to be 
transferred to the Player node.

4. Click Play Now.

The new content begins to play immediately in the selected player/region.
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11. Managing 
Sites

CoolSign is designed to support everything from a single standalone player to a large network 
of players located across the entire country or around the world. When you begin to deploy 
CoolSign players to multiple locations, it becomes useful to start thinking in terms of the sites 
where your players are installed—especially when each site may have multiple players and 
possibly a transfer server.

To help you organize the way you view your players and nodes, CoolSign Manager lets you 
define virtual sites that represent the physical locations where your players are deployed.

Using CoolSign Manager, you can easily create new sites, assign metadata to a site, and 
organize your players and nodes into sites that are viewable in a geographic tree hierarchy or 
flat view.

About sites
Sites are a tool to help you represent the geographic organization of the players in your 
network. A site does not represent an actual CoolSign player or transfer server but, rather, the 
location where one or more nodes are deployed. While it may be tempting to think of a 
transfer server as an equivalent to a site since, in most common network topologies, a single 
transfer server is located at each site, this is not always the case. For example, if your site only 
has a single player deployed at a site, it wouldn’t be necessary to also have a transfer server, 
but you would still want to represent the site for that player. Furthermore, transfer servers are 
often used to improve scalability in the NOC or regional locations and, therefore, don’t always 
represent a physical site.
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Sites are actually very similar to QuickSets with the following differences:

• Sites are only available for players and network nodes.
• Each node in a network can only belong to a single site.
• You can assign metadata to a site so that you can track business-related information.
• Sites can be viewed in a special geographic tree view.

Working with players and sites
Sites are available to help you organize how you view the players in your CoolSign network. 
You can organize your players into different sites and then use the site’s quickbar to quickly 
view all the players within a site or geographic region.

To view the sites quickbar for players:

1. Open the Players page by clicking the Players icon in the navigation bar.

2. By default, the sites quickbar should be visible to the left of the players grid. 

If the quickbar is not visible, choose Views > Quickbar to make it visible. If the sites panel is 
not visible, click the sites button in the quickbar.
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Viewing all the players within a site

When you click on a site node in the sites panel, the data grid displays only the players located 
in that site or geographic location. Clicking on a city, state, or country node shows you all of 
the players in all of the sites located underneath that node. This makes it easy to quickly filter 
your view of players from anywhere from a site up to all the players in a specific city, state, or 
country.

Clicking a site node in the sites panel also displays a site info panel above the data grid, with 
specific information about the site including its address, hours of operation and any other 
Attributes you have defined and set to display under the Site Hours.

Changing the sites panel view

By default, the sites panel shows a geographic tree view of your sites with levels for the 
country, state, and city. You can also choose to view your sites in a flat view without the 
geographic hierarchy. 

To change the sites panel view:

1. Click the Options button at the bottom of the sites panel.

2. Select Geo View for the default geographic tree view or Flat View to display just the site 
nodes.

Creating a new site

When installing CoolSign software to a new PC, you have the option to set the default site 
name for that player. When the player first connects to a CoolSign network, it adds itself to a 
site (if it already exists); otherwise, the player creates a new site with that name automatically. 
You can edit the properties of the player-created site to add geographic information or other 
metadata See “Editing site properties” on page 133.

You can create new sites as needed to reorganize your players.

To create a new site:

1. Right-click anywhere in the site panel to display the sites popup menu.
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2. Choose Create Site. A new Site Properties dialog appears. If you right-clicked on a country, 
state, or city node in the sites panel, the new site is automatically set to that geographic 
region.

3. Enter a site name.

4. Enter the address information for the site into the fields provided.

5. Click OK. A new empty site will be created in the site treelist.

Assigning a player to a site

Players can be assigned to a site when originally configured during installation. If your player 
was assigned during install to an incorrect site or was left to the “Default” site, you can easily 
reassign the player to a different site. 

WARNING!  Reassigning a player’s site does not change the physical topology of your network. You 
cannot point a player to a different transfer server just by changing its site. Sites are virtual organiza-
tions only.

To reassign a player to a different site:
• Select the player and drag/drop it onto a site in the site treelist. The player is reassigned to 

the new site.



Managing Sites

CoolSign v4.5  CoolSign Manager User Guide � 133

Note: You can only drop a player onto a site icon. You can’t drag onto the country, state, or city nodes 
in the site tree.

You can also reassign a player’s site from the Node Properties dialog on the Network page. For 
more information, see “Editing node properties” on page 210.

Editing site properties

Sites that are created automatically for new players do not contain any information other than 
the site’s name. You can edit the site to set geographic information, define the hours that the 
site is open, and add any custom user fields you desire. 

To edit a site’s properties:
• Right-click on the site’s node in the site treelist and choose Edit Site.

Setting the hours for a site

If your site represents a business or other commercial location, you can define the hours for 
which the site is open. You can use the site hours to restrict the range for which you retrieve 
playlogs to ensure that your play counts are only against the times when the site was actually 
open. 

Note: In CoolSign 4, site hours can only be used for tracking information about a site and when 
retrieving playlogs for a player. Players within a site will continue to play their schedules even if a site is 
scheduled to be closed at a certain time. If you want to schedule a player to start and stop playing at 
specific times, you can use the player’s display control schedule. Setting site hours is useful if you need 
to strictly track the number of plays for a piece of content and need to only count the hours which a 
site is actually open. This feature allows you to schedule the display control to turn the signs on before 
the site is actually open and after it is closed, but not include that time in the playlogs. 

For more information on retrieving playlogs, see “Retrieving play history for content” on 
page 68.

To set the open hours for a site:

1. From the Site Properties dialog, click the Site Hours tab.
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2. Using the site hours scheduling grid, set the schedule for which the site is open.

For more information on using scheduling grids, see Chapter 19, Using Schedule Grids, on 
page 231.

Add Attributes to a site

With the Attributes tab, you can add your own custom user fields to a site if you’d like to track 
additional data about each site that is relevant to your business.

Note: Attributes are only available to display in the site info panel or on the Site Properties dialog. You 
cannot use Attributes as dynamic data in your content or enabling expressions.

To add a custom user field to a site:

1. From the Site Properties dialog, click the Attributes tab.

2. Click Define Attributes to open the Site Attributes dialog.

Click directly into the value column of a 
user field to edit.
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3. Click Add to open a new Attribute Properties dialog.

4. Enter a name for the site Attribute.

5. Click OK.

Deleting a site

If you have an empty site, you can delete it so that it no longer appears in the sites panel. You 
can only delete sites that no longer contain any player nodes, transfer servers, or the network 
controller. When you delete the only remaining site for a city, state, or country, the site treelist 
will refresh to remove any geographic nodes that no longer contain any sites.

Note:  If transfer servers or the network controller are assigned to the site you are trying to delete, you 
must use the Networks page to reassign those nodes to another site first.

To delete a site:
• Right-click on the site node in the site treelist and choose Delete Site.

Enter the name of the new 
Attribute here.

Click the Use picklist check box to 
show a combobox with the values 
entered in the picklist area.

Check this box to let the user enter 
custom values into the combobox.
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19. Using 
Schedule Grids

You can use the scheduling grid to schedule a number of different properties of your CoolSign 
network, including any of the following:

• Dayparting a schedule item within a channel (Schedule Item Properties dialog).
• Volume level of a player (Player Properties dialog).
• Display control for a display connected to a player (Configure Players dialog).
• The hours that a site is open (Site Properties dialog).
• Bandwidth limiting for a node (Network Properties dialog).

Working with the schedule grid
The scheduling grid provides a powerful interface that can be easily used for most common 
scheduling, while also providing advanced features that allow you to build very complex 
schedules quickly.

All scheduling grids share the same interface, save for a context-sensitive popup menu that 
allows you to schedule the specific values available to the property you are scheduling. 

Depending on what you are scheduling, the colors of cells indicate different values for the 
property. For properties like volume and bandwidth limiting, each cell visually displays the 
percentage level of a value (as shown above). By default, clicking a cell or dragging across cells 
toggles the cell value between the minimum or off value and the maximum or on value. Right-
clicking on a cell or right-click dragging across cells displays a context-sensitive popup menu 
to enable you to set any additional value available to that property.

Setting a cell value in the grid

Each cell in the grid has a color that indicates the value of the property at that time. The 
possible values of a schedule grid and the corresponding colors are different for each type of 
scheduling grid and are discussed in detail in the documentation for the associated property 
dialog.
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You can quickly toggle the value of a cell or range of cells between the off and on settings. The 
off and on values of a property differ for each type of scheduling grid. For example, the on 
setting for the volume schedule grid indicates a volume of 100 while the on setting for the 
display control schedule grid indicates that the display’s input is set to CoolSign.

In addition to the off and on settings, some scheduling grids allow you to set additional 
values. For example, the volume scheduling grid lets you set a volume level from 0 to 100 and 
the display control scheduling grid lets you set the display to any labeled input.

To toggle cells between off and on:
• Left-click a cell or left-click and drag across one or more cells. All selected cells are toggled 

based on the first selected cell.

To set the value of a cell:

1. Right-click a cell or right-click and drag across a range of cells.

2. Select or set the value using the Value popup menu.

Click anywhere off the popup menu to close it.

Zooming into the scheduling grid

Each cell in the grid represents a block of time during a day of the week. By default, each block 
represents a full hour during the day. You can use the zoom controls to zoom in and out of the 
scheduling grid to decrease the block of time that a cell represents so you can schedule at 
finer resolutions than on the hour.

To zoom in:

• Click  to zoom into the grid. You can zoom to the following time resolutions: 1 hour, 30 
minutes, 15 minutes, 5 minutes, or 1 minute. 

To zoom out:
• Click  to zoom out of the grid.
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Overriding the recurring schedule
By default, when you are using the schedule grid, you are creating a recurring schedule that 
will repeat every week. If you want to modify the schedule for a specific week, you can use the 
override week features. For example, you may want to schedule displays to be on for extended 
hours during the week before Christmas at a department store or you may want to disable a 
schedule item from playing on a certain Tuesday in November for some reason. With the 
scheduling grid override functionality, you can schedule any overrides to the base recurring 
schedule for any future week.

To select a week to override:

1. Click the week selector box to display the datetime editor.

2. Use the month arrows to change the displayed month.

3. Click Today to jump to the current date.

4. Click Show Base Schedule to return to the base recurring schedule.

5. Click a day to select a week to override.

To navigate through weeks:
• Click the Forward or Back week selector buttons to move one week forward or back from 

the current week.

To override the schedule for a week:

1. Edit the schedule for an overridden week using the same tools available for editing the 
recurring week as described above.

Use the forward and back 
week selector buttons to 
navigate.

Use the week selector to 
jump to a week.

Click Override Options to display the 
Override menu.

Use the Override menu to clear over-
rides or jump to an existing overridden 
week.
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2. The overridden week is labeled as Overridden Week.

Selecting overridden weeks

You can quickly jump to any currently overridden weeks to review or modify the overrides. The 
Override Options menu indicates the number of weeks that are currently overridden.

To jump to an overridden week:

1. Click Override Options to display the Override popup menu.

2. Choose Jump to Override to display a submenu of any overridden weeks.

3. Choose the overridden week to jump to.

To jump to the next or previous overridden week:
• Hold down the Ctrl key while clicking the Forward or Back week selector buttons. If an 

overridden week is set, the schedule grid will jump to that week.

Clearing overridden weeks

You can remove all the overrides applied to a schedule or just the override for a specific week.

To clear all overridden weeks:
• Click Override Options and choose Clear All Overrides.

To clear the override from the currently selected week:
• Click Override Options and choose Clear Override For Current Week.
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